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1. Copyright & License Agreement
Copyright Notice

This document contains information proprietary to Número
Cinco Software, Ltd., hereafter designated as Number 5
Software. This document and the information contained within
is copyrighted to Number 5 Software and may not be
duplicated in full or part by any person without written
approval from Number 5 Software. While every effort has
been made to keep this information contained within current
and accurate as of the date of  publication, no guarantee is
given or implied that the document is error-free or that it is
accurate with regard to any specification. Number 5 Software
reserves the right to make changes, for the purpose of product
improvement, at any time.

End-User License Agreement
IMPORTANT – READ CAREFULLY : This Number 5
Software End-User License Agreement (EULA) is a legal
agreement between you (either an individual or a single entity)
and Number 5 Software for the software product described in
this user manual, which includes computer software and
associated media, printed materials, “online” and electronic
documentation (“SOFTWARE PRODUCT” or
“SOFTWARE”). By installing, copying, or otherwise using
the SOFTWARE PRODUCT, you agree to be bound by the
terms of this EULA. If you do not agree to the terms of this
EULA, promptly return the unused SOFTWARE PRODUCT
to the place from which you obtained it for full refund.

SOFTWARE PRODUCT License:

The SOFTWARE PRODUCT is protected by copyright laws,
international copyright treaties and the European Community Directive
91/250/EEC, as well as other intellectual property laws and treaties.
The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE. This EULA grants you the following rights:

Software: You may install and use one copy of the SOFTWARE
PRODUCT, or on its place, any prior version for the same operating
system, on a single computer.
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Storage/Network Use: You may also store or install a copy of the
SOFTWARE PRODUCT on a storage device, such as a network server,
used only to install or run the SOFTWARE PRODUCT on your other
computers over an internal network; however, you must acquire and
dedicate a license for each separate computer on which the SOFTWARE
PRODUCT is installed or run from a storage device.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

Limitations on Reverse Engineering, Decompilation and Disassambly:
You may not reverse engineer, decompile, or disassamble the
SOFTWARE PRODUCT, except and only to the extent that such
activity is expressly permitted applicable law notwithstanding this
limitations.

Rental: You may not rent or lease the SOFTWARE PRODUCT.

Software Transfer: You may permanently transfer all of your rights
under this EULA, provided you retain no copies, you transfer all of the
SOFTWARE PRODUCT (including all component parts, the media,
printed materials and any upgrades) and the recipient agrees to the
terms of this EULA. If the SOFTWARE PRODUCT is an upgrade, any
transfer must include all prior versions of the SOFTWARE PRODUCT.

Termination: Without prejudice to any other rights, Number 5 Software
may terminate this EULA if you fail to comply with the terms and
conditions of this EULA. In such event, you must destroy all copies of
the SOFTWARE PRODUCT and all of its component parts.

3. UPGRADES:

If the SOFTWARE PRODUCT is an upgrade from another product,
weather from Number 5 Software or another supplier, you may use or
transfer the SOFTWARE PRODUCT only in conjunction with that
upgraded product, unless you destroy the upgraded product. If the
SOFTWARE PRODUCT is an upgrade of a Number 5 Software product,
you now may use that upgraded product only in accordance with this
EULA. If the SOFTWARE PRODUCT is an upgrade of a component
of a package of software programs that you licensed as a single product,
the SOFTWARE PRODUCT may be used and transferred only as a part
of that single product package and may not be separated for use on
more than one computer.

4. COPYRIGHT:

All title and copyrights in and to the SOFTWARE PRODUCT (including
but not limited to any images, photographs, animation’s, video, audio,
music, text, and apples incorporated into the SOFTWARE PRODUCT),
the accompanying printed materials, and any copies of the SOFTWARE
PRODUCT, are owned by Number 5 Software or its suppliers. The
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SOFTWARE PRODUCT is protected by copyright laws and
international treaty provisions. Therefore, you must treat the
SOFTWARE PRODUCT like any other copyrighted material except
that you may either (a) make one copy of the SOFTWARE PRODUCT
solely for backup or archival purposes, or (b) install the SOFTWARE
PRODUCT on a single computer provided you keep the original solely
for backup or archival purposes. You may not copy the printed materials

accompanying the SOFTWARE PRODUCT.
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2. Getting Started

The following instructions tell you about minimum system
requirements, how to install the Card Software running
Windows 95 or windows NT 4.0 and start the program for the
first time.

Installation
MicrosoftÔ   Windows version 95 or later is required to install
and run the Card Software. You can run the Card Software on
any system that can run Windows 95, if the system has enough
RAM and hard disk space. If Windows 95 is not installed, run
the setup program for Windows before trying to install the
Card Software.

Running Setup on Windows 95
Insert the Card Software CD-ROM in your CD-ROM drive.
The Card Software Setup Screen appears after a few moments.

If the Card Software Setup Screen does not show up
automatically choose “Run” from the Windows 95 Start Menu

System Requirements
The recommended software and hardware configuration for
you computer system to run the Card Software is:

·   An IBM compatible PC with a Pentium microprocessor.

·   32 MB RAM.

·   Hard Disk with at least 50MB free disk space.

·   One CD-ROM 8X speed drive.

·   Network Novel Systems, Microsoft Network or similar
operating system, Windows 95 or NT 4.0 (Intel Processor only)

·   VGA or SVGA graphics adapter and monitor.

·   Mouse or other Windows-compatible pointing device.

·   Serial port.

·   SmartCard Reader and SmartCard Dongle.
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and type D:\setup, where D is your  CD-ROM drive letter.

Follow the Setup instructions.

Running Setup on Windows NT 4.0
Insert the Card Software CD-ROM in your CD-ROM drive.
The Card Software Setup Screen appears after a few moments.

If the Card Software Setup Screen does not show up
automatically choose “Run” from the Windows 95 Start Menu
and type D:\setup, where D is your CD-ROM drive letter.

Follow the Setup instructions.

Normal/Master Installation
Setup Instructions

The Language screen appears. Choose the desired language.
Click Install Software.

The Welcome Dialog box appears. Click Next to continue the
installation.

The license Agreement screen appears, if you agree with the
license terms confirm with Yes.

Setup prompts you with the Setup Installation Type. Choose
Normal/Master Installation and click Next.
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Setup prompts you with the default installation path. Confirm
or change the Card Software directory. Click Next.

Setup prompts you with the default group folder. Confirm or
change the Card Software Group folder. Click Next.

Setup will create a program group called Card Software and
program icons for the installed programs.

The installation is complete when the setup dialog box
confirms so. The Card Software setup will  prompt you to
reboot the system, highly recommended.
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Net License Installation
Setup Instructions

The Language screen appears. Choose the desired language.
Click Install Software.

The Welcome Dialog box appears. Click Next to continue the
installation.
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The license Agreement screen appears, if you agree with the
license terms confirm with Yes.

Setup prompts you with the Setup Installation Type. Choose
Net License Installation and click Next.

Use the Browse button to specify the full path for the Master
Installation. Please remember this important notes:

·   The drive mapping must be permanent (Reconnect at Logon).

·   You cannot change the drive letter.

·   This Network License always needs to know the Path to the
Master Installation.

·   You cannot execute this Network Version when the Master
Computer is turned off.

Click Next.
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Setup prompts you with the default installation path. Confirm
or change the Card Software directory. Click Next.

Setup prompts you with the default group folder. Confirm or
change the Card Software Group folder. Click Next.

Setup will create a program group called Card Software and
program icons for the installed programs.
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The installation is complete when the setup dialog box
confirms so. The Card Software setup will  prompt you to
reboot the system, highly recommended.

Setup Options
Depending on your Card Software version and operating
system, Setup will prompt you to install the Data Access Pack
(Advanced Feature). Highly recommended unless you already
have Data Access Pack installed.

The Data Access Pack installation will start.
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The Microsoft Data Access Pack Setup dialog box appears.
Setups prompts you with the default installation path. Confirm
or change the Data Access directory. Click Ok.

To start the installation click the large button.
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The Microsoft Data Access Pack - Maintenance dialog box
appears. Click the Select All button, click Ok.

The Microsoft Data Access Pack  installation is complete
when the setup dialog box confirms so.

Starting/Quitting the Card Software
After you have installed the Card Software, you can start the
application.

Connect the SmartCard reader to the serial port and enter the
SmartCard Dongle delivered with the package which is the
software key.
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Note: The SmartCard Reader is connected to the serial port in
a pass through manner, so you can connect it to the same
serial port as your mouse.

Starting
·      After you run Setup, you will see a program group in the

Windows Program Manager called “Card Software” or
another name you may have provided during installation.

·      The “Card Software” program group includes icons for all
the Card Software components you installed.

·      Double click the Card Software program icon.

Starting Windows with the Card Software
·                If you want to start the Card Software each time you start

Windows, move or copy the Card Software icon to the
Startup program group in Program Manager. For more
information about starting programs automatically from
within Windows, see your Windows documentation.

Quitting
·     When you finish working with the program and are ready

to quit the Card Software, choose the Exit command from
the File menu (or press Alt+F4 on the keyboard). If you
have made any changes since the last time you saved
your card file, the Card Software prompts you to save the
file before exiting. Click Yes to save the changes.
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3. Learning the Card Software

The Card Software user manual will guide you through this
powerful application, starting with creating a simple card work-
ing with objects and using system variables to the advanced
features like Database, Image Acquisition Logins and Pass-
words. All about Printing and Encoding you find in Appendix
A and B of this manual. Complementary the Card Software
Help function is a complete online tool, you can use anytime
you need information quickly or when your Card Software
User Manual is not available.

Note: Some features described in this manual are not available
in all Card Software editions.

Using the Card Software Manual
Before you start using the Card Software, it’s important to
understand the terms and typographical conventions we use
in the documentation.

General Conventions
We use the following kinds of formatting in the text to identify
special information:

· ¨  Diamond bullet: Step-by-step procedures. You can use
procedural information by using both the mouse and
keyboard. To choose a command from a menu, you can use
either the mouse or a keyboard shortcut.

· CAPITAL LETTERS : Keys on the keyboard appear in small
capital letters. For example, the Enter key appears as ENTER.

· When we ask you to press a combination of keys, you’ll see
them connected by a +. For example, CTRL+P means to
press the CTRL key and the P key at the same time.

· Capitalized Words: Commands you choose from the menus
or dialog boxes appear capitalized. For example, you choose
the Rectangle command from the Draw menu.
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· Also, tool and button names are capitalized. For example,
you use the Text Tool to type text, and the Bar Code Tool to
define a bar code.

Mouse Conventions
The Card Software makes use of both mouse buttons. Unless
you’ve programmed it differently, the left mouse button is the
primary mouse button. Whenever a procedure tells you to
use the secondary mouse button, the documentation refers
to it as the right mouse button.

· “Point”  means to position the mouse pointer so the tip of
the pointer rests on whatever you want to point to on the
screen.

· “Click”  means to press and then immediately release the
left mouse button without moving the mouse.

· “Double-click”  means to press and immediately release the
mouse button twice without moving the mouse.

· “Drag”  means to point, and then hold down the mouse
button as you move the mouse. Releasing the mouse button
completes the action.

· “Right-click”  means to press and then immediately release
the right mouse button with out moving the mouse.

Special Graphical Conventions
· Note - Indicates information that emphasizes or supplements

important points of the main text.
· Tip - A type of note that helps you apply the techniques and

procedures described in the text to your specific needs. A
tip suggests alternative methods that may not be obvious
and helps you understand the Card Software benefits and
capabilities.

· Important - Provides information essential to the completion
of a task. You can disregard information in a note and still
complete a task, but you should not disregard an important
note.

· Caution - A note that advises you that failure to take or
avoid a specified action could result in loss of data.

· Warning - A note that advises you that failure to take or
avoid a specific action could result in physical harm to you
or the hardware.
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Using Online Help
You can view the Card Software Online Help Contents window
by choosing Contents from the Help menu.

Getting Help
·    You can get help in several ways. For example, you can use
the Help button on the Upper Toolbar to get context-sensitive
help about items on the screen and commands.

·    Context sensitive help is always available by pressing the
F1 key from any screen.

· Advanced Feature – Describes alternative methods using
advanced features of Card Software (not available in all
editions, see chapter “23. Appendix C - Card Software Basic
Features” to know if your edition supports a specific feature).

From this window, you can “jump” to more-specific
information.
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·    In addition, many dialog boxes and message windows
contain a Help button. To use the comprehensive online index,
open the Card Software Help Contents window. To use other
features in Help, use the Help command. You can even get
help about how to use the Help system. Choose Using Help
from the Help menu.

Search Help Topic
·    The fastest way to get help on a topic is to use the search
feature. To open the Search dialog box, choose Contents from
the Help menu, then click Search.

Online Help Information
·    To see what’s in Help, choose Contents from the Help
menu in the Upper Toolbar. Then, click Using Card Software.
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·    You can display step-by-step procedures while you’re
working on a card. To do this, choose Contents from the Help
menu and, from the Contents window, click How To.

·    Scroll the screen to see the content covered in each Help
entry, and click the entry you want. You can move or resize
the Help topic window if it covers your card.
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Topical Help
To find out about an item on the screen, click the Help button
on the Upper Toolbar.

When the pointer changes to a question mark, choose the
command or click the window item on which you want help.
The Card Software displays the Help topic for the selected
command or window item in the Help window.

The Main Card Software Window
·    The main Card Software window, with its accompanying
toolbars and menus, closely resembles the windows you work
in for other Windows based programs. You will be working in
the main window (and its sub-windows) as you design and
print your cards.

·    The following illustration identifies and names each part of
the main Card Software window. The text explains how each
part functions.

The Title Bar
·    The title bar displays the name of the Card Software program
and the name of the active card file.
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The Menu Bar
·    The Menu bar lists the available menus. A menu contains
a list of commands, or actions, you can carry out with the
Card Software.

Close Button
·    Using the mouse, you can click the Close button to end
your Card Software session.

Minimize, Maximize Button
·    Using the mouse, you can click the Maximize button to
enlarge the active program window so that it fills the entire
desktop, or you can click the Minimize button to reduce the
window to an icon.

Restore Button
·    Using the mouse, you can click the Restore button a
window to its previous size and location. The restore button
is only available when your window is maximized.

The Scroll Bars
·    When the Card Work Area is zoomed-in (enlarged), Scroll
Bars appear that you can use to view information that exists
beyond the borders of the window. When you can view all
the contents of the window without scrolling, the Scroll Bars
are absent. Drag a Scroll Box or click one of the Scroll Arrows
to scroll the window and move the desired part of the card
image into view.

The Standard Status Bars
·    Messages appear toward the top and at the bottom of the
window in areas called status bars. These messages describe
what you are seeing and doing in the Card Software window
as you work.

·    The Upper Status Bar displays the x and y coordinates of
the pointer, and the type, location, and size of the currently
selected card object.

·    The Lower Status Bar displays the name of the tool when
selecting the tool’s button.
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·    When you choose a command, the Lower Status Bar
provides a short message telling you what that command will
do.

The Toolbars
· You can use toolbars for quick access to some of the most

commonly used commands and tools. The Standard Tool
Bar contains mostly common Windows commands, the
Database Tool Bar and the Drawing Tool Bar contains only
Card Software command buttons.
Tooltips explaining the functions of each button are
displayed if you hold the mouse pointer over the desired
button.

Note: You must use a mouse to choose buttons on the toolbars.
You cannot use the keyboard.

The Card Work Area
· All your work to lay out a card is done in the Card Work

Area. This area displays a card outline depicting the physical
limits of the card. Any objects placed outside the card borders
will not be printed.

The Split Window Bar
Used to separate vertically the Card Work Area Window from
the Database Window. The split window can be sized with the
mouse.

The Database Window
Advanced Feature

Displays all data field names and provides a field to enter or
edit data, for the current database.

Field Name
Advanced Feature

Display the database field names.



34 Card Software User Manual

Screen Setup
·    Using the command Toolbars on the View menu, you can
display or hide any of the individual Card Software Toolbars.

·    Using commands on the view menu you can, also display
or hide the card-edge guidelines (CTRL+L) .

·    The Show Grid and Grid Settings commands on the Options
menu let you display or hide the layout grid (CTRL+G) , and
control grid spacing and color.

Zooming the Card Image
·    The size of the card image can be changed by using the
Zoom In (+) and Zoom Out (-) commands on the View menu.
Exact placement of objects on the card is sometimes easier if
the image is larger.

Data Field
Advanced Feature

Used to enter and display database data.



 Card Software User Manual 35

Toolbar Commands
·    The Card Software toolbars provide you with one-step
access to lots of tasks. You can draw a rectangle, place a
photograph, define a bar code, edit text and much more - all
with just one click of a mouse button on one of the Card
Software tools.

·    For more information about each of the Card Software
toolbars, see Chapter 15 Toolbars and Tools.

Menu Commands
·    Commands are grouped in menus. Some commands carry
out an action immediately; others display a dialog box so that
you can select options. You’ll know that a command will
display a dialog box, if it is followed by three periods (...).

Working with the Card Software Commands
· A command is an instruction that tells the Card Software to

perform an operation. The Card Software provides several
ways for you to choose commands. You can choose
commands from a menu or toolbar, or you can use shortcut
keys.

Mouse Shortcuts
·    You can use a mouse shortcut to give you quick access an
object’s property sheet, or to display a shortcut menu.

¨  To display an object’s property sheet.

1. Point to the object.
2. Click the right mouse button. The object is selected,

and its property sheet appears.
3. Choose the property you want to change.
4. When you have finished with the property dialog box,

click OK or Cancel, or press ESC.
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Shortcut Keys
· You can choose some commands by pressing the keyboard

shortcut keys listed on the menu to the right of the command.
· The Card Software uses many of the shortcut keys found in

other Windows programs. You find a list of shortcut keys in
Chapter 16 - “Keyboard Shortcuts”.

¨   To display the Shortcut menu.

1. Move the mouse pointer to a place not on an object.
2. Click the right mouse button. The Shortcut menu

appears.

3. Choose the action you want to perform.

¨   To display the Shortcut menu when you have multiple
objects selected.

1. Move the mouse pointer over the selection.
2. Click the right mouse button. The Shortcut menu

appears.

3. Choose the action you want to perform.
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4. Creating Cards

This section explains the procedures for opening existing card
files, saving your work and creating the layout of a new card.

Opening and Saving Card Files
You’ll find that opening and saving your card files are pretty
much the same as in other Windows programs.

Opening Card Files

 To create a new card at any time, click the New button on
the Standard toolbar. To quickly open one of the last cards
you worked on, choose it from the list of recently used files at
the bottom of the File menu.

 To open an existing card, click the Open button on the
upper toolbar. When the Open dialog box appears, select the
document in the File Name box, and then click OK.

If you don’t see the Card you want
·    The File Name box initially lists card files in the directory in
which you last saved or opened a card. If the card file you
want is not listed, click another drive and/or directory.

·    If you choose, you can open several card files during a
Card Software session. Use the methods listed above to select
the desired card files. If more than one window is open, the
title bar for the active window (the one in which you are
working) is a different color or intensity than other title bars.

Saving Card Files
Until you give a new card document a unique name, the Card
Software displays in the title bar a temporary name. The first
new document is CARD1, the second, CARD2 and so on.
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  To save a card on disk, click the Save button on the
Standard tool bar. When you save a card for the first time, the
Card Software displays the Save As dialog box so that you
can type a name for the card file.

Naming a Document
·    To make it easier to find your documents, you can use long,
descriptive filenames. The complete path to the file, including
drive letter, server name, folder path, and filename, can contain
up to 255 characters. Filenames cannot include any of the
following characters: forward slash (/), backslash (\), greater-
than sign (>), less-than sign (<), asterisk (*), question mark
(?), quotation mark (“), pipe symbol (|), colon (:), or semicolon
(;).

Displaying Card Information
·    You can display information about the current card. From
the View menu, choose Card Info . The Full Card Document
Information box appears. This selection displays the name of
the person who was the last to work with the card, and the last
save and print dates.
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·    To see more technical detail about the card, click Tech.
Details. The Card Draw Technical Information dialog box
appears. When finished viewing, click OK .

Creating a Basic Card
This section explains the processes involved in creating a
basic card using a few of the most common tools.

Card Setup
 A card can be created in either portrait (print across the narrow
side of the card) or landscape (print across the wide side of
the card) orientation. The card defaults to landscape
orientation. To set the card orientation to portrait, on the File
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menu choose Card Setup. In the Card Setup dialog box, click
Portrait . The card orientation can be changed at any time.

Note: For more information on card setup when working with
a windows printer driver see Chapter 21. Appendix A - Printing
& Ribbon.

Adding a Line
¨  To add a horizontal or vertical line

  1.On the drawing toolbar, click the Line tool; the pointer
changes to a hand with the Line icon.

2. Move the pointer to the point on the card where you
want to place one end of the line.

3. Press and hold the left mouse button and drag in a
horizontal or vertical direction. As you drag , a line is
drawn, with one end fixed where you began to drag , and
the other end following the pointer. Continue dragging
until the line is the desired length.

4. Release the mouse button. The line appears on the card.

Adding a Rectangle
 ̈ To add a rectangle

  1. On the drawing toolbar, click the Rectangle
tool; the pointer changes to a hand with the Rectangle
icon.

2. Move the pointer to the point on the card where you
want to place the upper left corner of the rectangle.
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Adding Text
¨  To add text

  1. On the drawing toolbar, click the Text tool;
the pointer changes to a hand with the Text icon.

2. Move the pointer to the point on the card where you
want to place a corner.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms with one corner
fixed where you began to drag, and the other corner
following the pointer. Continue dragging until the
rectangle is the desired size.

4. Release the mouse button. The Text Properties dialog
box appears.

5. Type some text into the box, for example: “Card Software”.
6. Click OK to complete the action.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms with one corner
fixed where you began to drag, and the other corner
following the pointer. Continue dragging until the
rectangle is the desired size.

4. Release the mouse button. The rectangle appears on the
card.
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Adding an Image
¨  To add an Image to the card

 1.On the Drawing toolbar , click the Image tool; the
pointer changes to a hand with the Image icon.

2. Move the pointer to the point on the card where you
want to place the upper left corner of the image.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms with one corner
fixed where you began to drag, and the other corner
following the pointer. Continue dragging until the
rectangle is the desired size.

4. Release the mouse button. The Image Properties dialog
box appears.

5. Click Open from File. The Import Bitmap dialog box
appears.
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Adding a Bar Code
¨   To add a bar code to the card

  1. On the drawing toolbar, click the BarCode
tool; the pointer changes to a hand with the BarCode
icon.

2. Move the pointer to a place on the card where you want
to place a corner of the barcode.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms, with one corner
fixed where you began to drag. The other corner follows

6. Choose a file name that has one of the extensions listed
in the List Files of Type box, for example, tiger.bmp. Click
OK . The image will appear on the screen with its upper
left corner at the position you clicked in step 3.

Note: The previous steps showed you how to add a
photograph (or other artwork) to your card from a bitmap file.
You can also add an image that is not in a file by using the
Scan… button, or the VfW Image Source. See Chapter 12 -
“Image Acquisition”

Tip: Use the Card Software Clipart Viewer to choose and import
an image from your Card Software 4.0 CD-ROM.  See Chapter
6 - “Clipart Viewer”
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the pointer. Continue dragging until the rectangle is the desired
size.

4. Release the mouse button. The Barcode Properties dialog
box appears.

5. Select a bar code Style from the list. Card Software defaults
to Code 39, but you can choose from among the 20 styles
listed.

6. Type the data you want to appear in the barcode.
7. Select the barcode Ratio from among the four listed.
8. If you want the bar code printed in an orientation other

than horizontal (0 Degrees), select a Rotation value of
90, 180, or 270 degrees. The rotation is measured
clockwise from horizontal.

9. If you want the bar code to print with the best black
contrast to a white or light colored background, select
the Print in Black Panel check box. This will print the
barcode with the black panel of the ribbon instead of
using the three ribbon colors to process black. Bar codes
require high contrast for applications where verification
is required.

10. The five remaining check boxes pertain to the
characteristics of the printed barcode. See Chapter 17
“About Bar Codes.”

11. Click OK . The bar code will appear on the card.



 Card Software User Manual 45

Adding a PDF Symbol
¨   To add a PDF Symbol

  1. On the drawing toolbar, click the PDF Symbol
tool; the pointer changes to a hand with the PDF icon.

2. Move the pointer to a place on the card where you want
to place a corner of the PDF symbol.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms, with one corner
fixed where you began to drag; the other corner follows
the pointer. Continue dragging until the rectangle is the
desired size.

4. Release the mouse button. The PDF Symbol Properties
dialog box appears.

5. Type the data you want to appear in the PDF symbol.
6. If you want the PDF symbol printed in an orientation

other than horizontal (0 Degrees), select a Rotation value
of 90, 180, or 270 degrees. The rotation is measured
clockwise from horizontal.

Note: While some bar codes will accept numbers, letters and
symbols, others will accept only numbers. See Chapter 17
“About Bar Codes.”
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7. If you want the PDF symbol to print with the best black
contrast to a white or light colored background, select
the Print in Black Panel check box. This will print the
PDF symbol with the black panel of the ribbon instead of
using the three ribbon colors to form a “process” black.
Use Print in Black Panel for the best results.

8. The five remaining check boxes pertain to the
characteristics of the printed PDF symbol. See Chapter
18  “About PDF Symbols”

9. Click OK . The PDF symbol will appear on the card.
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5. Working with Objects

This section provides information on objects, their properties,
and how to edit them.

Card Software Objects
With the exception of magnetic encoding information and Smart
Card data, all cards are made up of objects. Lines, text, images,
bar codes are objects. What you can do with an object
depends on whether you created it in the Card Software or
you inserted it from another application.

Once you know how to manipulate the different types of
objects, you’ve mastered a lot of what’s involved in creating
cards.

Terms That Apply to Objects
As you’ve already discovered, objects are the key building
blocks in the Card Software. Just about everything you work
on is an object. There are different types of objects, and the
behavior of an object depends on its type. The Card Software
objects are native to the Card Software; embedded objects
are objects you create in another application. Some of the
terms used to describe working with objects may be new to
you.

· Object: The text, lines, and bar codes that you create using
the Card Software tools and the pictures you import from
other applications.

· Property: Each aspect of an object that you can manipulate
using the Card Software tools and commands, including size,
color, line width, and content.

· Sizing handle: The square at each corner and along the sides
of a selected object. Dragging a sizing handle resizes the
object.

· Selection rectangle: The box framed by the sizing handles
when an object is selected. When you click an object to
select it, the selection rectangle appears.
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· Picture: An image from another application. It can have some,
but not all, of the attributes of an object created in the Card
Software. You can move and resize a picture and change its
rotation.

· Grid : An invisible network of lines that covers the card. As
you draw objects, their corners align on or “snap to” the
nearest intersection of the grid, if Snap-to-Grid is checked in
the grid settings dialog box (on the Options menu). Although
you can’t see the grid lines, the intersections of the lines
appear as dots on your screen. You can turn the grid on and
off using the Show Grid command on the Options menu
(CTRL+G) .

· Stacking: Placing objects on top of one another. Each object
is separate from any other object as well as from the card
background. Although the objects seem to be drawn on a
flat card, it’s helpful to think of objects as pieces of paper in
a stack. The object you draw first is on the bottom of the
stack; the most recently drawn object is added to the top of
the stack. The “stacking order” is important because the
object on the top of the stack can cover those underneath it.
You can see this effect when you stack one filled rectangle
on top of an-other.
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Selecting and Deselecting Objects
You need to tell to the Card Software, which object you want
to work with. To do this, you must select it.

¨  To select one object

1. Touch a visible part of the object with the mouse pointer,
and then click. You select an object in a stack in the same
way.

2. Once it’s selected, you’re free to rotate it, change its size,
or color, or move it to another location.

¨  To select multiple objects

1. Hold down the SHIFT key and click each object you
want to select.

- or -

2. Move the pointer outside of the objects you want to
select.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms, with one corner
fixed where you began to drag, and the other corner
following the pointer. Continue dragging until the
rectangle encloses all the objects you want to select.

4. Release the browse button. The objects enclosed by the
rectangle are selected.

¨  To select all objects

1. From the Edit menu, choose All , or press CTRL+A .

¨  To deselect objects

1. Click anywhere outside the object(s), or press Esc.

Tip : An object will be selected automatically if you right-
click the object to edit its properties.
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Resizing Objects
You can change the size of an object by dragging one of the
sizing handles that surround a selected object.

Tip:  If you want to resize an object (except a bar code) by an
exact amount or to a specific size, use the object’s property
dialog box.

¨  To resize an object

1. Select the object.
2. Move the mouse pointer over a sizing handle. The pointer

changes appearance to indicate the direction in which
you can resize the object.

3. Click and drag a sizing handle until the outline of the
object is the right shape and size.
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Resizing Text
¨  To resize text

1. Select the text object.
2. Right-click the object. The Text Properties dialog box

appears.
3. Type or select the desired Point Size.
4. Click OK . The text is changed to the new size.

Note: See “Editing Object Properties” for more detailed
information.

Resizing a Line
¨  To resize a line

1. Select the line. Sizing handles appear on each end of the
line.

2. Drag one of the sizing handles to make the line the length
you want.

Resizing a Bar Code
You can resize a bar code only by using the sizing handles.
The bar code property sheet does not have width and height
information.

Important : Resizing a bar code requires special consideration
to maintain the correct aspect ratio and data density for the
bar code type being printed. See Chapter 17, “About Bar
Codes.”

Resizing a PDF Symbol
You cannot resize a PDF Symbol. It’s appearance depends on
the amount of encoded Data and the output resolution set-
tings. See Chapter 18 - “About PDF Symbols”.
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Moving and Aligning Objects
Naturally, you’ll want to move objects on your cards as you
create them. And sometimes you’ll need to line up objects in
a particular way - along the bottom of the card, perhaps, or
with each other.

Moving Objects
¨   To move an object

1. Select the object. When you move an object, a dotted
outline appears as you drag.

2. Drag the object to its new location.

Tip : You can place an object more precisely if it’s not trying to
snap to the grid. Disable the Snap to Grid checkbox in the Grid
Settings dialog box from the Options menu (CTRL+H ).

Warning:  If the card work area is zoomed to a high level
clicking on an object will align it’s right border with the right
border of the card workspace window.  Avoid moving objects
in a high zoom level.
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Aligning Objects
You can align objects by using the Card Software Snap to
Grid  feature.

¨  To align objects

1. From the Options menu, select Show Grid (CTRL+G ).
The grid will appear on the card.

2. From the Options menu, select Grid Settings. The Grid
Settings dialog box will appear.

3. Select the Snap to Grid checkbox. Type or select the
Spacing Width and Height to provide adequate grid
spacing.

4. Select and move the objects to be aligned. The upper left
corner of the object will snap to the grid, providing a
reference location for alignment.

Rotating Objects
You can rotate bar codes, images, and single lines of text in 90
degrees increments.

¨  To rotate an object

1. Select a bar code, image, or single-line text object.
2. Right-click the selected object to display the object’s

property sheet.
3. Select the desired rotation amount.
4. Click OK . The object will be rotated to the new position.

Tip : To rotate the entire card 180 degrees when the card is
printed, select Rotate 180 degrees in the Card Print dialog box.

Stacking Objects
When you’re working with objects, you’ll find that you
sometimes stack them to get the effect you want. When you
stack objects on top of each other, they overlap. Sometimes
you’ll want to change their order - put the top object on the
bottom, for example.
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Duplicating Objects
Duplicating an object creates a copy of the object that’s
slightly offset from the original.

The Duplicate command doesn’t place a copy of the object
on the Clipboard.

¨  To duplicate an object

1. Select the object.
2. From the Edit menu, choose Duplicate Item or press

CTRL+D .
3. The duplicated item appears on top of the object you

selected. Drag it to place it where you want it.

Tip : You can use the Duplicate command to make an array of
objects.

The Card Software has two commands you can use to move
objects up or down in a stack. Having these commands means
you don’t have to keep track of the order of the objects as
you draw them. That is, you don’t have to draw the bottom
object first, then the object that would be next on the stack,
and so on.

You can draw objects in any order and then move them up
and down the stack as needed.

¨   To stack an object

1. Select the object you want to move up or down in the
stack.

2. On the upper toolbar, click the Move to Front or the Move
to Back tool.

3. The selected object will be placed at the front or the back
of the stack.

Tip : If you are working with stack of three objects and want to
place the front object in the middle, select the middle object
and move it to the front.
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Editing Object Properties
Each object has certain properties associated with it. You can
change the properties of an object editing its Object Properties
dialog box.

The Card Software provides two ways to display an object’s
property dialog box: using a menu command or using a mouse
shortcut.

¨  To use a menu command to edit an object’s properties

1. From the Edit menu, choose Item List . The Edit Item List
dialog box appears.

2. Select an object from the List of Card Items.
3. Click Edit Props…. The Object Property dialog box

appears.
4. Examine or change any properties.
5. Click OK.

Note: If you select an image you can export it (the Save As
dialog box appears) to any directory in your computer system.
See later in this chapter in section “Item List”.
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¨  To use a mouse shortcut to edit an object’s properties

1. In the Card Work Area, right-click the object whose
properties you want to edit.

2. The Object Properties dialog box appears.
3. Examine or change any properties.
4. Click OK.

Line Properties
Line properties are:

· Line Length: Enter the desired line length.
· Line Width : Enter the desired line width.
· Color: Click Color. The Color dialog box appears. Select

the desired color. Click OK .
· Protected: If checked, you can turn the object not

selectable enabling the ‘Activate Protected Objects’
function from the Options menu.

Note: You can set a default line width. From the Options menu,
choose Change Line Width. Enter the desired default line
width. Click OK . All new line objects, including rectangles,
will be drawn with the new width.

Rectangle Properties
Rectangle properties are:

· Rectangle Width: Enter the desired width.
· Rectangle Height: Enter the desired height.
· Line Width:  Enter the desired line width.
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· Color: Click Color. The Color dialog box appears. Select
the desired color. Click OK .

· Protected: If checked, you can turn the object not
selectable enabling the ‘Activate Protected Objects’
function from the Options menu.

Filled Rectangle Properties
Filled Rectangle properties are:

· Rectangle Width: Enter the desired width.
· Rectangle Height: Enter the desired height.
· Color: Click Color. The Color dialog box appears. Select

the desired color. Click OK.
· Protected: If checked, you can turn the object not

selectable enabling the ‘Activate Protected Objects’
function from the Options menu.

Text Properties
Text properties affect the position of the text on the card, and
its appearance. How your text looks depends on the attributes
you assign to it. (Think of an attribute as a characteristic of
the text - its font, size, color, whether it is italic or boldface,
and so on.)
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Style Examples of text attributes

Regular: Card Software works wonders.

Bold: Card Software works wonders.

Italic: Card Software works wonders.

Bold Italic: Card Software works wonders.

You use the Font and the Font Color dialog boxes to change
text attributes.

Note: The attributes you select apply to all the text comprising
the selected text object. You cannot, for example, make one
word bold and leave the rest of the text regular. If you want
text with different attributes, use the Text tool to create another
text object. Then, apply the desired attributes to the new text
object.

Text properties are:

· Text: Type the text you want to appear on the card.
· Font type and style: Click Font. The Font dialog box

appears. Select the desired font and style.
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· Point Size: Enter the desired size. Point size can also be
changed from the Font dialog box.

· Font Color: Click Font Color. The Color dialog box
appears. Select the desired color.

· Rotation: If you are printing only one line of text, you
can rotate the text from the default horizontal orientation.
Select a rotation value of 90, 180, or 270 degrees. The
rotation is measured clockwise from horizontal.
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Note: The Rotation property is unavailable if there is more
than one line of text.

· Alignment: Determines the position of the text on the
card. Select the desired horizontal and vertical text
alignment.
Horizontal alignment specifies how the text is aligned
horizontally in respect to the text box on the card.

Vertical alignment specifies how the text is aligned
vertically in respect to the text box on the card.

Note: The vertical alignment options are unavailable if there is
more than one line of text.

· Print in Black Panel: If you want the text to be printed
with the black panel of the ribbon, select the Print in
Black Panel check box.

· Protected: If checked, you can turn the object not
selectable enabling the ‘Activate Protected Objects’
function from the Options menu.

Selecting and Editing Text
Important : You cannot edit text directly on the screen in the
Card Work Area. You edit text only by displaying it in the Text
Properties dialog box.

Note: In the following sections, when the manual refers to
editing text it means adding, replacing, deleting or otherwise
changing the text box content, not the text attributes.



 Card Software User Manual 61

Deleting Text
¨  Delete a character

1. Position the pointer after the character you want to delete,
click and then press BACKSPACE.

¨  Edit text

1. Right-click the text object you wish to edit.
2. The Text Properties dialog box appears.
3. Using the techniques listed below, select the text you

want to edit.
4. Perform the desired alterations.
5. Click OK .

¨  Select text using the mouse

1. Point where you want the selection to begin, and then
drag over the text.

2. To select a single word, double-click the word.

¨   Select text using keyboard shortcuts

· For keyboard enthusiasts, selecting text using the
keyboard is often faster than using the mouse.

To select Press

One character right: SHIFT+RIGHT ARROW

One character left: SHIFT+LEFT ARROW

To end of word:CTRL+SHIFT+RIGHT ARROW

To start of word: CTRL+SHIFT+LEFT ARROW

One line up: SHIFT+UP ARROW

One line down: SHIFT+DOWN ARROW
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Cutting, Copying and Pasting Text
¨  Cut or copy and paste a block of text

1. Drag the text to select it; then, press CTRL+X  (cut) or
CTRL+C (copy).

2. Position the pointer where you want to paste the text and
click.

3. With text on the Windows clipboard (cut or copied), press
CTRL+V  (paste).

¨  To delete a block of text

1. Drag across the text to highlight it, and then press
BACKSPACE or DELETE .

Image Properties
Image properties are:

· Image Width: Select the desired width for the image.
· Image Height: Select the desired height for the image.
· Keep Aspect: Select this check box to keep the same

horizontal to vertical aspect ratio when changing the
image size. This will prevent image distortion.

· Rotation: You can rotate the image from the default
horizontal orientation. Select a rotation value of 90, 180,
or 270 degrees. Rotation is measured clockwise from
horizontal.

· Protected: If checked, you can turn the object not
selectable enabling the ‘Activate Protected Objects’
function from the Options menu.

· Print in Black Panel: If you want the image to be printed
with the black panel of the printer ribbon, select the Print
in Black Panel check box. Print in Black Panel is recom-
mended for signature files or similar.
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Note: Double Clicking an image will distort it occupying the
sizing rectangle completely. Double Click again to return to
the previous appearance

Image Tools
Click Tools. The Image Tools dialog box appears. A collection
of tool buttons and menu commands are available to enhance
the selected image.



64 Card Software User Manual

Edit Menu
· Undo: Reverses the last command performed and returns

the image to its previous state. Quickly perform this
command clicking the corresponding tool button.

· Keep Ratio: The tracker rectangle maintains its previously
defined height and width relation.

Image Menu
· Adjust Colors:  The command Contrast decreases or

increases an image contrast by moving the RGB (red ,
green, blue) tracker bar. Unlock the control field Lock to
change values for RGB separately. Quickly perform this
command clicking the corresponding tool button. The
command Brightness  decreases or increases image
brightness by moving the RGB tracker bar. Unlock the
control field Lock to change values for RGB separately.
Quickly perform this command clicking the corresponding
tool button.

· Effects: The command Blur decreases the contrast
between pixels, the image appears smoother. Sharpen
increases the contrast between pixels, the image appears
more focused. Sharpen More has the same effect, but
with higher intensity. High Contrast lets you set a
threshold value to kodalith an image

· Grayscale: Converts the image from color to gray

· Remove Noise: Removes graining by averaging areas of
the image.

· Crop: This command is only available, after selecting an
image area with the select button from the image tools
toolbar. Define the area you want to keep by dragging
and resizing the selection rectangle. Then use the
command Crop from the Image menu.

· Resize:  Select the desired value, then click Resize.
· Kodalith : Displays the Input Values dialog box. Enter the

desired value, then click OK.
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Exit Menu
· Exit : Closes the Image Tools dialog box, saving all settings

made.

Cancel Menu
· Cancel: Closes the Image Tools dialog box, not saving

any settings made.

Image Tools Toolbar
Gives you fast access to the main image tools commands

· Arrow : Deselects Zoom and Crop tool
· Select: The mousepointer changes to a fine cross. Define

the area you want to crop by dragging and resizing the
selection rectangle.

· Zoom: Select this tool to zoom in (by leftclicking) or out
(by rightclicking).

· Undo: Reverses the last command performed and returns
the image to its previous state.

· Brightness and Contrast: Fast access to adjust image
colors as described above.
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Bar Code Properties

Bar code properties are:

· Style: Select the type of bar code you wish to print.
· Data: Type the data you want to appear in the bar code.

Ensure the data is valid for the selected bar code style.
· Ratio: Select the desired bar code ratio.
· Rotation: You can rotate the bar code from the default

horizontal orientation. Select a rotation value of 90, 180,
or 270 degrees. Rotation is measured clockwise from
horizontal.

· Print in Black Panel: If you want the bar code to be
printed with the black panel of the printer ribbon, select
the Print in Black Panel check box. Print in Black Panel is
recommended for best contrast and readability.

· Check Digit: Select this check box if you want a check
digit to be added to the data when the bar code is printed.

· Show Data: Select this check box if you want the data to
be printed in human readable form below the bar code
symbol.

· Horizontal Bars: Select this check box if you want
horizontal protection bars added to the printed bar code
symbol.

· Vertical Bars: Select this check box if you want vertical
bars added to the printed bar code symbol.
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· Spacer: Select this check box if you want a spacer
character added to the printed bar code symbol.

· Protected: If checked, you can turn the object not
selectable enabling the ‘Activate Protected Objects’
function from the Options menu.

Note: While some bar codes will accept numbers, letters and
symbols, others will accept only numbers. See Chapter 17,
“About Bar Codes.”

PDF Symbol Properties

PDF symbol properties are:

· Data to Encode: Type the data you want to appear in the
bar code. Ensure the data is valid for the PDF bar code
style.

· Number of Rows: Select the desired number of rows.
· Number of Columns: Select the desired number of

columns.
· ECC Level: Select the desired ECC level.
· ECC Percent: Select the desired ECC percent, if ECC level

is set to Auto.
· Flip Option:  Select the desired flip option: None, Left/

Right, Top/Bottom, or Flip Both.
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· Protected: If checked, you can turn the object not
selectable enabling the ‘Activate Protected Objects’
function from the Options menu.

· Output Resolution X, Y: Select the desired x and y
resolution. This specifies the symbol’s aspect ratio, used
during symbol encoding for row and column calculations.

· Rotation: You can rotate the bar code from the default
horizontal orientation. Select a rotation value of 90, 180,
or 270 degrees. Rotation is measured clockwise from
horizontal.

· Reduce Bar Width: Select to reduce the bar width.
· Reduce Bar Height: Select to reduce the bar height.
· Print in Black Panel: Select if you want the bar code to

be printed with the black panel of the printer ribbon. Print
in Black Panel is recommended for the best contrast and
readability.

· Binary Encode: Select to encode the data in binary.
· Truncated: Select to truncate.

Note: For more information on the characteristics of PDF
symbols see Chapter 18, “About PDF symbols.”

Overlay Properties

Overlay properties are:

· Overlay coverage: From the Choose Overlay box, select
the overlay coverage desired.
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· Predefined Overlays: If the selected overlay coverage
was “Predefined Selected Area Without Overlay,” se-
lect one of the option buttons.

Tip : If you select one of the Predefined Overlays option
buttons, the overlay coverage box will automatically be set to
“Predefined Selected Area Without Overlay.”

· Bitmap: If the selected overlay coverage was “Bitmap
Based Overlay,” type the path of the *.bmp (bitmap) file
you wish to use as overlay pattern. If you don’t know
the file name, click Browse to select the file. The Bitmap
Based Overlay concept was designed to provide the
possibility to create a hologram effect on the printed
card. It is based on a monochrome pattern, which tells
the printer to spare out all dark areas in the bitmap when
printing the overlay, which produces the “hologram” ef-
fect.

Tip : Use black & white images for bitmap overlay. Anyway,
you may use a colored bitmap. The Card Software will
automatically convert your bitmap to Black & White.

· Preview on Screen: Select this checkbox if you want to
see the overlay depicted on the screen. For the Bitmap
Based Overlay there is no preview on  screen.

· X, Y Placement: Use these boxes if the selected overlay
coverage was “User Selected Area, With Overlay” or
“User Selected Area, Without Overlay.” They define the
horizontal (X) and vertical (Y) location of the upper-left
corner of the overlay area. The overlay in this area is
printed or not printed depending on which user selected
area was chosen.

· Width, Height : These boxes define the size of the over-
lay area, it’s origin  (0,0) is defined by the X, Y Placement
values.
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Tip : For more information on this subject, see Chapter 8
“Overlay”.

Items List
····· To open the Items List dialog box select Items List from

the edit menu or press Ctrl+I. You can change object
properties directly from this dialog box, useful if you want
to change small or hidden items. You also can export
images (in bitmap format, *.bmp) from this menu.

Note: Only image and text objects have a preview.

· Export : Select an image and click this button to export it.
The Save As dialog box appears. Provide a filename for
your image. It will be saved as bitmap (*.bmp)

· Edit Properties: Select any object and click this button.
The corresponding Object Properties dialog box opens.
Perform the changes you want and confirm with OK .
Changes are applied immediately at the card workspace.

· Delete: Click this button to delete permanently the selected
item. Confirm with OK.

· Close: Exit Edit Item List dialog box.
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6. Clipart Viewer

The Clipart Viewer is a simple, but powerful tool to browse
through the clipart samples, which are provided with the Card
Software CD-ROM. You also can use it for any other clipart
library, assembled by bitmap (*.bmp) images.

The Clipart Viewer Utility
Starting Clipart Viewer

¨  Open the Clipart Viewer

1. Open the “Card Software” program group and double-
click the Clipart Viewer  program icon.

2. The main Clipart Viewer window appears.
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Clipart Viewer Toolbar

   ·      Up and down button: Scrolls through images

vertically.

   ·      Left and right button : Changes the number of

image columns by + or - 1.

Tip : You can set the number of columns directly to 2, 4, 8, 12 or
20. Right-click the left or right button and choose the number
of columns you want.

 · Open button: Opens the directory of a clipart library
in your computer system.

· Quick Browse: Two drop down menus to quickly select
the image category you want. Choose between black
& white images and select one of the categories
available in Clipart Volume I or II.

  · Print button : Prints a page of all images in the
current directory.

 · Info button : Displays information on number 5
software.

 · Close button: Exits the Clipart Viewer

Note: The Clipart Viewer searches automatically for Clipart
Volume I or II at drive C, D, E and F. If Clipart Volume I or II are
not found, it opens with a blank screen.
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Export an Image
¨  Export an image to your card working area

1. Choose an Image and click on it. The Image Info window
appears. The image is displayed in its true size
(measurement in pixels) and automatically exported to
the Windows clipboard.

2. Activate the Card Software and select Use Windows
Clipboard  from the Edit menu.

Tip:  You can toggle between the Card Software and Clipart
Viewer pressing Alt + Tab.

3. Import the image from the Windows Clipboard. Select
Paste from the Edit menu.

Tip : Use the keyboard shortcut Ctrl + V  to paste the image.
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7. Working with Variables

This section explains how to use variable data with the Card
Software.

Variable Data
· Contrary to fixed data, which is edited when the card is

designed, variable data changes. It is edited or becomes
available at the time the card is printed. When you design
the card, instead of typing the actual data, you create a
placeholder called a variable. At print time, the variable data
replaces your named variable at its location on the card.

· Some of the sources for variable data are: the computer
keyboard, internal information that the computer system
keeps track of the date and time, ODBC sources and
concatenation of sources.

· Before variable data can be used with the tools that support
it (text, bar code, PDF, image or magnetic encoding), you
must create and name a variable field for each piece of
information you wish to add to the card at print time. This
named field then becomes the “target” for the data when
you print the card.

· This eliminates the need to manually edit the card to enter
each piece of data before printing. You can use the same
card format, knowing that your card design will remain
constant, with only the variable data changing from card to
card.

The Variable Sources
· Global Counter: An integer counter that starts at a

number that you choose, and, each time you print a
card, is increased by the value of a second number that
you choose.



 Card Software User Manual 75

· Printer Counter: An integer counter that starts at 1
and is increased by 1 each time you print a card.

· Keyboard Input:  Data that you type from the computer
system’s keyboard.

· Date/Time: The Date/Time kept by your computer
system.
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· Image Sources:
File Choose Image: At print time, the Card
Software will prompt you to select the name of an
image file.
Scan Image: An image acquired from any twain
compliant source at print time. See Chapter 12  -
“Image acquisition”.

· Concatenation: Data that result from the concatenation
of two or more sources. In the Prefix, Separator and
Suffix boxes you can edit constant data. To achieve
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Adding Variable Data

· MCI An image acquired from MCI-compliant source
(see Chapter 12 - “Image Acquisition”).

· ODBC Data from internal or external database that you
can access using ODBC (see Chapter 12 - “Image
Acquisition”).

Variable Image
¨  To add a variable image to a card

 1.On the lower toolbar, click the Image tool; the pointer
changes to a hand with the Image icon.

2. Move the mouse pointer to the point on the card where
you want to place the upper left corner of the image.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms, with one corner
fixed where you began to drag, and the other corner
following the pointer. Continue dragging until the
rectangle is the desired size.

Tip : You can change one or both of the dimensions, but you
should ensure that Keep Aspect is checked. Doing so will
maintain accurate image proportions.

4. Release the mouse button. The Image Properties dialog
box appears.
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5. Set the Variable Source as Image Source, and the click
Properties, the Source Image Properties dialog box will
appear.

6. Choose the Image Source you want and click OK . The
image box you created in step 3 will appear on the (on-
screen) card with two diagonal lines through it. This
indicates that the image will be provided at print time.

Tip : Select  the Show Images Tools checkbox if you want to
modify the image at print time.

7. The image box you created in step 3 will appear on the
(on-screen) card with two diagonal lines through it. This
indicates that the image will be provided at print time.

  8. On the Standard toolbar, click the Printer Tool .
The Card Print Dialog box appears (See Chapter 21 -
Appendix A- “Printing & Ribbon”).

9. Click OK , to complete the action.
10. Depending on the selection you made at step 6, you will

be prompted to choose an image file or to acquire the
image from your twain source.

11. Repeat step 8 to 10 as many times as needed to print any
number of cards, with a different image on each card.

Note: More information about how to use image sources you
find in Chapter 12 - “Image Acquisition”.
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Variable Text
¨  To add variable text

The following steps assume you want to create a variable text
object “Employee Name” for the employee’s name. At print
time, you will type the employee’s name on the keyboard, so
you set the Variable Source field to Keyboard Input.

Advanced Feature: You could also create a database with all
the information about the employee names and set the variable
source to ODBC Source. See Chapter 10 - “Card Software and
Database”.

  1. On the lower toolbar, click the Text tool; the
pointer changes to a hand with the Text icon.

2. Move the mouse pointer to the point on the card where
you want to place a corner.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms, with one corner
fixed where you began to drag, and the other corner
following the pointer. Continue dragging until the
rectangle is the desired size.

4. Release the mouse button. The Text Properties dialog
box appears.
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5. Set the Variable Source as Keyboard Input . The Source
Keyboard Input Properties Dialog Box appears.

6. Type “Employee Name” as default text on the Source
Keyboard Input Properties Dialog box

7. Click OK  to confirm and close the Source Keyboard
Input Properties Dialog box.

8. Click OK  to confirm and close the Text Properties Dialog
box.

9. The text box you created on step 3 will appear on the
(on-screen) card with the words “Employee Name”
inside. This indicates that the text (the employee’s name)
will be provided at print time.

  10.  On the Standard toolbar, click the Printer Tool. The
Card Print dialog box appears (See Chapter 21 - Appendix
A “Printing & Ribbons”).

11. Click OK . The Text Input Dialog box appears prompting
you to enter data for the employee’s name.

12. Enter the employee’s name and confirm with OK .

Note: Repeat step 10 to 12 as many times as needed to print
any number of cards, with a different name on each card.
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Variable Bar Code
¨  To add a variable bar code

The following steps assume you want to create a variable
barcode for the Employee’s ID Number. At print time, you will
type the employee’s ID number on the keyboard, so you set
the Variable Source field to Keyboard Input.

Advanced Feature: You could also create a database with all
the information about the employee’s and set the variable
source field to ODBC Source. See Chapter 10, “Card Software
and Database”.

  1. On the lower toolbar, click the Barcode tool;
the pointer changes to a hand with the Barcode icon.

2. Move the mouse pointer to a place on the card where
you want to place a corner of the barcode.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms, with one corner
fixed where you began to drag; the other corner follows
the pointer. Continue dragging until the rectangle is the
desired size.

4. Release the mouse button. The Barcode Properties dialog
box appears.
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5. Select a barcode Style from the list. The Card Software
defaults to Code 39, but you can choose from among the
20 styles listed (See Chapter 17 - “About Bar Codes”).

6. Set the Variable Source as Keyboard Input. The Source
Keyboard Input Properties Dialog Box appears.

7. Type “Employee’s ID Number” as default text on the
Source Keyboard Input Properties Dialog box.

8. Click OK to confirm and close the Source Keyboard
Input Properties Dialog Box.

9. Click OK to close the Barcode Properties dialog box.
10. The bar code, which appears on the (on-screen) card,

contains the encrypted information “Employee’s ID
Number”. At print time you’ll provide the correct data.

  11.   On the Standard toolbar, click the Printer Tool . The
Card Print dialog box appears (See Chapter 21 - Appendix
A  “Printing & Ribbon”).

12. Click OK . The Text Input Dialog box appears prompting
you to enter data to the employee’s ID number.

Note: repeat step 11 and 12 as many times as needed to print
any number of cards, with a different barcode on each card.
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Variable PDF
¨  To add a Variable PDF Symbol

The following steps assume you want to create a variable
PDF symbol for the Employee’s ID Number. At print time, you
will type the employee’s ID number on the keyboard, so you
set the Variable Source field to Keyboard Input.

Advanced Feature: You could also create a database with all
the information about the employee’s and set the Variable
source field to ODBC Source. See Chapter 10, “Card Software
and Database”

  1. On the lower toolbar, click the PDF Symbol
tool; the pointer changes to a hand with the PDF Symbol
icon.

2. Move the mouse pointer to a place on the card where
you want to place a corner of the PDF Symbol.

3. Press and hold the left mouse button and drag in any
direction. As you drag, a rectangle forms, with one corner
fixed where you began to drag; the other corner follows
the pointer. Continue dragging until the rectangle is the
desired size.

4. Release the mouse button. The PDF Symbol Properties
dialog box appears.

Important : While some bar codes will accept numbers, letters
and symbols, others will accept only numbers. See Chapter 17
-  “About Bar Codes.”
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5. Select the desired options for the PDF symbol (See
Chapter 18 -  “About PDF Symbols”)

6. Set the Variable Source as Keyboard Input. The Source
Keyboard Input Properties Dialog Box appears.

7. Type “Employee’s ID Number” as default text on the
Source Keyboard Input Properties Dialog box.

8. Click OK  to confirm and close the Source Keyboard
Input Properties Dialog Box.

9. Click OK  to close the PDF Symbol Properties dialog
box.

10. The PDF Symbol, which appears on the (on-screen) card,
contains the encrypted information “Employee’s ID
Number”. At print time you’ll provide the correct data.

  11. On the Standard toolbar, click the Printer Tool .
The Card Print dialog box appears (See Chapter 21-
Appendix A  “Printing & Ribbon”).
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12. Click OK . The Text Input Dialog box appears prompting
you to enter data to the employee’s ID number.

Note: repeat step 11 and 12 as many times as needed to print
any number of cards, with a different PDF Symbol on each
card.
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8. Overlay

An overlay (or varnish layer) is a thin transparent coating
applied to a card to protect the underlying printed information
from wear. You can include a bitmap pattern in the overlay as
a security measure, creating a hologram effect.

Defining an Overlay
¨  To define an overlay

1. From the Drawing Tools menu or Drawing Toolbar, choose
Overlay Clipping.

- or -

2. Click the right mouse button on a place not on an object.
The Shortcut menu appears. Choose Overlay Clipping.

3. The Overlay Properties dialog box appears.

As you define the overlay, the Overlay Preview section will
show the area of the card where the overlay will be applied.

4. In the Choose Overlay list box, select the desired overlay
type:

Full Overlay (the default): The overlay varnish is applied
over the entire surface of the card.

No Overlay: No overlay varnish is applied to the card.
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User Selected Area, With Overlay: The overlay varnish is
applied only to the area you define.

User Selected Area, Without Overlay: The overlay varnish
is applied to the entire surface of the card except to the area
you define.

Bitmap Based Overlay: In the Choose bitmap for Overlay list
box you select or browse a bitmap file on disk to use as the
overlay.

Tip:  the bitmap should be monochrome (e.g.: black & white,
where white defines areas with overlay varnish). The size of
the bitmap should be the same as the card size (85,34mm *
52,83mm), to achieve varnish coverage over the whole card.
Anyway the Card Software automatically transforms 2 colored
bitmap to black & white and adjust it to the right size. This
may cause some distortion.

Predefined Selected Area Without Overlay: This overlay
varnish is automatically selected if you choose one of the
following predefined area selections:

· Smart Card ISO
· Smart Card AFNOR
· Magnetic Stripe

5. Define the position and size of the overlay or the ex-
cluded area.Type the x and y coordinate values in the X
Placement and Y Placement boxes. These numbers indi-
cate the coordinates of the upper left corner of the over-
lay area. The origin (0, 0 point) is the upper left corner of
the card. The x and y coordinates are measured from the
origin. The Width and Height numbers indicate the size
of the overlay or the excluded area.

6. If you wish to see the overlay area depicted on the card,
select the Preview on Screen check box, bitmap based
overlay has no preview. Those areas of the card with an
overlay will be shown with an array of the letter “O”.
Those areas of the card with no overlay will be shown an
array of the letter “N”.
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 Overlay area.

 No Overlay area.

7. Click OK. You have defined the overlay.
8. You can change the position or resize the overlay on the

card:
To Resize the overlay it must be selected, then drag the two
head arrow anywhere in the card.

To Move the overlay it must be selected, then drag the four
head arrow any where in the card.

Important:  Because the overlay is used to protect  the printed
information, overlay should not be applied to card areas con-
taining the magnetic stripe, smart chips, or barcodes. Parts of
Card Objects which reach into  User Selected Area Without
Overlay or Predefined Selected Area Without Overlay are not
printed. Areas without overlay appear white.

Printing Overlay with Memory Extension: The printable area
without Memory Extension  (ME) does not cover all the card
surface, only with ME the printable area is extended to the
edge of the card, and the whole card can be printed with
overlay.

Important:  You may not delete the overlay (Item List from the
Edit menu). If you want to print without overlay, choose the
Overlay Clipping Option from the Options Menu and enable
the option No Overlay. It is not allowed to send the object
overlay to the other layer. To print both sides of the card with
overlay, you need to choose the option Overlay Clipping from
the Options Menu for both sides. With the feature Front and
Back the overlay can be managed in both sides of the card
independently.
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Bitmap Based Overlay
¨   To prepare a bitmap and define overlay properties

1. Use a Windows™ application, like Paint to draw the
bitmap. Set width = 85.3mm and height = 52.8mm. Type
the number in the area where you want it later to appear
on your card. Use black letters. Save the image as bitmap
(phone.bmp)

2. From the Options menu, choose Overlay Clipping.
- or -

3. Click the right mouse button on a place not on an object.
The Shortcut menu appears. Choose Overlay Clipping.

The Overlay Properties dialog box appears. In the Overlay
Properties dialog box choose Bitmap Based Overlay. Browse
to the overlay bitmap, you have created before. The overlay
is printed in all white areas, sparing out the black number.
Holding the printed card against the light, the number appears
as a kind of hologram. Click Ok. You have created and selected
a bitmap file to be used as overlay.

Note: you may only use one kind of overlay types for the
same card side.
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9. Chip Card

If your printer is equipped with a chip card encoder, you can
encode data onto memory cards.

About Chip Cards
There are two basic types of chip cards: the memory card and
the intelligent card.

· Memory Card:  Can store a certain amount of data, which
can be subsequently altered, but not adequately
secured.

· Intelligent Card:  Better known as smart card, the
intelligent card has, like a PC, a memory, a central
processing unit and a communications unit. As the smart
card can carry out calculations it makes it easy to
implement effective security features.

The chip has three types of memory: ROM, EEPROM and
RAM

· ROM:  contains fixed information, which remains at all
times and cannot be changed.

· EEPROM: can be changed and remains in the chip even
when no electrical power is flowing through the chip.

· RAM:  temporary memory, which can be changed, but
disappears when no electrical power is flowing through
the card.

Chip Card Process
· The Card Software allows to plug-in an executable file

during the printing process. The Card Software will call
an external chip card processing software.

· To run this software you have to provide the necessary
parameters in the Chip Card Properties dialog box.

· At print time the Card Software will position the card on
the chip interface of your Privilege printer and call the
external software.



 Card Software User Manual 91

· The Card Software continues the print process either on
user command or after receiving a return file OK-message
(see “setting the chip card properties”).

Chip Card Properties
¨  Setting the chip card properties

  1. At the Drawing Toolbar click the Chip Card
button. The Chip Card Properties dialog box appears.

2. Type the path of the executable file of your chip card
processing software in the Command Line box. You can
also click the Browse button next to the Command Line
box. The Choose Application dialog box appears. Select
the directory of your executable file and click OK .

3. Set (optional) the arguments supported by your chip card
processing software in the arguments box.
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4. From the Source drop-down box select the data source
(variables) you want to provide (See Chapter 7
“Working with Variables”). The data source you defined
will be displayed in the Source Data box.

5. From the Runtime Options section select how you want
the print process to continue.

· On User Command you have to click the Continue
button in the Chip Card Process dialog box, after the
chip card encoding process terminated.

Note: If you click the Abort button the complete printing
process will be canceled.

· On Return File “OK”  the Card Software continues the
printing process automatically, after receiving an OK-
message from a file created and returned by the chip
card processing software. Type the path of your return
file in the Return File box. You can also click the Browse
button next to the Return File box. The Choose Return
File dialog box appears. Select the directory of your
return file and click OK .

6. Click the OK button to confirm all settings.



 Card Software User Manual 93

Chip Card Encoding
¨  The chip card encoding process

1. From the File menu choose Card Print . The Card Print
Dialog Box appears (see Chapter 21 - Appendix A
“Printing & Ribbon”). Select in the operation section the
Chip Card Processing check box. Click OK  to start the
chip card encoding process.

Note: You can also select Print and Encode in the operation
section. The operation sequence is set as: first chip card
encoding, second magnetic encoding and third print.

2. Depending on your setting of the runtime options, either
the Chip Card Process dialog box appears or the Card
Software waits for a return file (see “setting the chip card
properties”).
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10. Card Software and Database

This section explains how to work with the Card Software and
databases. Learn how to create your own database from within
the Card Software and how to connect to an external database
using ODBC drivers.

Introduction to ODBC
ODBC Basics

The Card Software accesses databases through ODBC drivers,
using SQL language.

The Open Database Connectivity (ODBC) interface allows
accessing data in Database Management Systems (DBMS)
using Structured Query Language (SQL) as a standard for
accessing data.

ODBC allows different database technologies to be used by
defining a standard interface.

File Formats
To access any database format from the Card Software you
will need the ODBC driver for that standard. The default
drivers, which come with the Card Software CD-ROM supply
the most common formats:

Microsoft Access Driver (*.MDB)

Microsoft dBase Driver (*.DBF)

Microsoft Excel Driver(*.XLS)

Microsoft FoxPro Driver(*.DBF)

Microsoft Paradox Driver(*.DB)

Microsoft Text Files Driver(*.TXT ; *.CSV)

Microsoft Visual FoxPro Driver

SQL Server
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Note: You can add anytime your specific drivers to meet your
needs. Just as an example, you can add drivers to access
AS400 files directly from the Card Software.

Purpose of ODBC
ODBC was created as a way of setting a standard to access
data on files. Using concepts like layers and layer abstraction,
it allows the user to access data on his hard disk, in a local
network or even in a Wide Area Network, using desktop or
server/client specifications, in any database format that have
available ODBC driver.

Desktop versus Server/Client
Desktop file access means, that the file is accessed opening it
as a disk file, in the local hard disk or even in a local network.

Server/Client supposes that somewhere a DBMS server is
running. The local machine sends requests to the server
resulting in data available to the client.

The Card Software does the access to both types in an easy
and similar way. One difference will be that in a DBMS Server
the user will need to “login” the database.

Card Software Sources
Card Software classifies data in two classes:

Internal Data Sources, which it assures to exist and
automatically configures.

External Data Sources, which must be configured by the user
running the ODBC administrator to gain access to his files.

Basically both data types use the same methods. Internal Data
Sources make life easier for a user, who does not have a
database system already installed.

SQL
SQL (Structured Query Language) is the standard that the
Card Software uses to “talk” to ODBC, issuing commands to
read and write data on the files.
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Card Software / driver architecture
The ODBC Desktop Database Drivers allow you to open and
query a database through the Open Database Connectivity
(ODBC) interface.

Application/driver architecture for Win16/Win32s
applications:

Application (16-bit)     Application (32-bit)

| |

32-Bit Thunking Driver Manager

(ODBC32.DLL)

| |
ODBC

Universal Thunking DLL

(ODBC16UT.DLL)

| |

ODBC Driver Manager

(ODBC.DLL)

|

ODBC Desktop Database Driver

(ODBCJT16.DLL, MSAJT200.DLL, 16-bit Driver ISAM))

|

database
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Application/driver architecture for Win32
applications:

Application (16-bit)      Application (32-bit)

|
|

ODBC Driver Manager

(ODBC.DLL)

|
|

16-Bit ODBC Generic Thunking DLL

(ODBC16GT.DLL)

|
|

32-Bit ODBC Generic Thunking DLL

(ODBC32GT.DLL)

|
|

ODBC Driver Manager

(ODBC32.DLL)

| |

ODBC Desktop Database Driver

(ODBCJT32.DLL, MSJT2032.DLL, 32-bit Driver ISAM)

|

database

Database Structure
Database, Table, Record, Field, Data: Those five terms build
the structure of a database. It is easy to understand which
meaning each term has, if you imagine an office closet.

Database: the office closet itself

Table: a card-index box inside the closet

Record: a file-card inside the card-index box

Field (Column): a predefined part of the file-card, for example
name field or address field, etc.

Data: the particulars typed in the name field
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Data Type
About Data Types

Database columns are defined to contain a certain type of
data, the most commonly used data type is maybe CHAR
(stands for character). You need to define different data types
for each column, if you want to store data like images directly
in a column.

Each database format supports different data types, which
are translated by the ODBC driver into a SQL data type. This
allows an application to interact with a database bi-
directionally.  This interaction is not 100%, though, as each
different driver imposes certain limitations.

Card Software Internal Database Data Types
The Card Software supports five Data types: Text, Number,
Integer Number, Photo and Memo.

Text: The data type text builds a single lined field, which may
contain up to 254 characters.

Number: The data type number builds a single lined field,
which may contain any value between 1.7e-308 to 1.7e+308

Integer Number: The data type integer number builds a single
lined field, which may contain any value between  -
2,147,483,648 and 2,147,483,647

Memo: The data type Memo builds a multi-line field for text
editing.

Photo: The data type Photo builds a field, which allows the
storage of an image.

Data Source
Introduction

Before you can access data with an ODBC driver, you must
add a data source for it.  You can change or delete a data
source at any time. A data source contains the information
which ODBC driver is to be used, including driver specific
setup and the indication where to find the database itself.

See section External Database later in this chapter to learn,
how to work with data sources.
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Card Software Internal Database

Create a New Internal Database
¨  Creating an internal Card Software Database (Advanced
Feature)

1. From the Database menu choose Connect. The ODBC
Source Selection dialog box appears. Select Create Data-
base.

2. The Create Database dialog box appears. Type the data-
base name, for example CAMPANY and click Create.

3. Select the Database you just created and click Next. The
list of the available tables appears and prompts you to
select the table you want to work with. As there is no table
available yet, you have to create it, by clicking New Table.
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4. The Database Table Structure dialog box appears. Pro-
ceed as explained later in this chapter “Create a New Ta-
ble”.

¨  Creating a Card Software Database (Advanced Feature)

1. Some editions of the Card Software are specially designed
to access an external , already existing database (see chap-
ter “23. Appendix C - Card Software Basic Features” to
see if your edition supports this feature). If you need to
create a database from within the Card Software you must
use the MsAccess  ODBC driver setup (see later in this
chapter at section “Setup MsAccess Data Source”).
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Open an Internal Database
¨  Opening an Internal Card Software Database (Advanced
Feature)

1. From the Database menu choose Connect. The ODBC
Source Selection dialog box appears. Select the
database filename you want and click Next.

2.    Select the operation you want to perform, and proceed
as explained later in the chapter section “Working with
Tables”.

Disconnect from a Database
¨  Disconnect from a Database
1. From the Database menu choose Disconnect.

Note: As soon as  you link a database field to the card layout,
this option is disabled.

Working With Tables

Create a new Table
¨  Create a new table
1.   After connecting successfully to an Internal Card Software

database the select table dialog box appears.
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2.   Click New. The Database  Table Structure dialog box
appears.

3.   Type the table name (e.g.: Clients_Hardware); You may
not use the space character do separate words, as it
provokes a syntax error in the create table statement.

4.   Define the columns. For each column you want to create
provide column name (e.g.: Name, Idnumber and Photo)
or use the default name (Field1, Field2, Field3)

5.    Select column data type (see section Card Software internal
database data type earlier in this chapter) and length (if
necessary).
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6.   Provide the type of Index you want to apply to the column.
An index is used to control data storage and queries in a
column. Choose between None (in this case, no indexing
occurs), Unique (indexed, each record must contain unique
data, used to set a primary key) or Duplicate (indexed, but
allows equal data, speeds up queries).

Note: The field RECORD_NR is automatically created and
indexed as unique to provide at least one column, where data
differs in all records (primary key). This is to avoid affection
on multiple records at delete or edit operations. You may delete
this column, but you should provide at least one column
indexed as unique.

7.  Remove a column: choose this options if you want to
remove a column from your table.

8.   Create your table by clicking Finish. The Select Table
dialog box appears. Your table named Clients is
highlighted. Choose it by clicking Finish.
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9.   The database view appears in a split-window next to the
card view. Use the database toolbar to navigate, add new,
modify or delete records (see as explained later in this
chapter section “The Card Software Database Functions”).

Edit an existing Table
¨  Edit a table

1. After connecting successfully to an internal Card
Software database the select table dialog box appears.
Select the table you want to change.
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2. Click Modify . The Database  Table Structure dialog box
appears.

3. Add and Remove Columns as explained in the section
Create a New Table earlier in this chapter.
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Remove a Table
¨   Remove a table

1.   After connecting successfully to an internal Card Soft-
ware database the select table dialog box appears. Select
the table you want to remove.

2.    Select the table you want to remove and click Remove.
The Card Software prompts you with a warning message.
If you really want to remove permanently the table you
selected confirm by clicking Yes.

Connect to an External Database

ODBC Source Selection
Before you can connect to a database you must define a data
source first (as explained earlier in this chapter in section “Data
Source”). When you connect to a database for the first time,
you will find default data sources listed in the Data Source
Selection dialog box. These sources are set for each of the
installed drivers, defining the default driver settings and the
default database directory, which is c:\windows\system\. To
connect to your database you have to setup a new data source
for it first (or edit an existing source). The next sections explain,
driver specific, the ODBC data source setup.
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Setup MS Access Data Source
¨   How to setup a MS Access data source:

1.  From the database menu click Connect. The ODBC Source
Sglection dialog box opens. Click the ODBC Manager button.
The Microsoft ODBC Data Source Administrator dialog box
opens.

2.  Click the Add… button to setup a new data source. The
Create New Data Source dialog box appears. Select Microsoft
Access Driver (*.mdb) and click Finish.
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3.  The ODBC Microsoft Access 97 Setup dialog box appears.
Type the name that identifies the data source, such as “Clients
List ”.

4.  Description field: An optional description of the data in the
data source; for example, “Hire date, salary history, and current
review of all clients.”

5.  Disable the Use current Directory check box. Click the
Select… button and browse to the database you want to
connect

6.  If you need to create a new database, select the Create
button and provide a file name in the appearing new database
dialog box and confirm with Ok. This newly created database
doesn’t contain any tables, for information how to create and
edit new tables refer to section “Working with Tables” earlier
in this chapter.

7.  For more information on Advanced and Options see
Microsoft documentation

8.  Click OK to confirm all settings and end your ODBC
session clicking the OK button in the ODBC Data Source
Administrator dialog box. You are back to the ODBC Source
Selection dialog box.
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¨   How to Select the MS Access data source:

1.  Click the Refresh button in the ODBC Source Selection
dialog box. Browse through the available data source listing
until you find the name of the data source (for example:
“Clients List”) you just defined and click the Next button.

2.  The Select table dialog box appears. Select the table you
want to work with and click Finish. The database view appears
in a split-window next to the card view. Use the database
toolbar to navigate, add new, modify or delete records (see
section “The Card Software database Functions” later in this
chapter).

Setup MS dBase Data Source
¨   How to setup a MS dBase data source:

1.  From the database menu click connect. The ODBC Source
Selection dialog box opens. Click the ODBC Manager button.
The Microsoft ODBC Data Source Administrator dialog box
opens.



110 Card Software User Manual

2.  Click the Add… button to setup a new data source. The
Create New Data Source dialog box appears. Select Microsoft
dBase Driver (*.dbf) and click Finish.

3.  The ODBC Microsoft dBase Setup dialog box appears.
Type the name that identifies the data source, such as
“Suppliers List”.

4.  Description field: An optional description of the data in the
data source; for example, “Hire date, salary history, and current
review of all suppliers.”
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5.  Select the correct dBase version (dBase III, IV or 5.0)

6.  Disable the use current directory check box and click the
Select Directory… button and browse to the database you
want to connect.

7.  For more information on Select Indexes… and Options>>
see Microsoft documentation.

8.  Click OK  to confirm all settings and end your ODBC session
clicking the OK button in the ODBC Data Source
Administrator dialog box. You are back to the ODBC Source
Selection dialog box.

¨   How to Select the MS DBase data source:

1.  Click the Refresh button in the ODBC Source Selection
dialog box. Browse through the available data source listing
until you find the name of the data source (for example:
“Suppliers List”) you just defined and click the Next button.
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2.  The Select table dialog box appears. Select the table you
want to work with and click finish. The database view appears
in a split-window next to the card view. Use the database
toolbar to navigate, add new, modify or delete records (see
section “The Card Software Functions” later in this chapter).

Setup MS Excel Data Source
¨   How to setup a MS Excel data source:

1.  From the database menu click connect. The ODBC Source
Selection dialog box opens. Click the ODBC Manager button.
The Microsoft ODBC Data Source Administrator dialog box
opens.

2.  Click the Add… button to setup a new data source. The
Create New Data Source dialog box appears. Select Microsoft
Excel Driver (*.xls) and click Finish.
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3.   The ODBC Microsoft Excel Setup dialog box appears.
Type the name that identifies the data source, such as
“Distributors List ”.

4.  Description field: An optional description of the data in the
data source; for example, “Hire date, salary history, and current
review of all distributors.”

5.  Select the correct Excel version (Excel III, IV or 5.0)

6.  Disable the use current directory check box and click the
Select Directory… button and browse to the database you
want to connect.

7.  For more information on Options>> see Microsoft
documentation.
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8.  Click OK to confirm all settings and end your ODBC
session clicking the OK button in the ODBC Data Source
Administrator dialog box. You are back to the ODBC Source
Selection dialog box.

¨   How to Select the MS Excel data source:

1.  Click the refresh button in the ODBC Source Selection
dialog box. Browse through the available data source listing
until you find the name of the data source (for example:
“Distributors List ”) you just defined and click the Next
button.

2.  The Select table dialog box appears. Select the table you
want to work with and click Finish. The database view appears
in a split-window next to the card view. Use the database
toolbar to navigate, add new, modify or delete records (see
section “The Card Software Database Functions” later in this
chapter).
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Setup MS FoxPro Data Source
¨   How to setup a MS FoxPro data source:

1.  From the database menu click Connect. The ODBC Source
Selection dialog box opens. Click the ODBC Manager button.
The Microsoft ODBC Data Source Administrator dialog box
opens.

2.  Click the Add… button to setup a new data source. The
Create New Data Source dialog box appears. Select Microsoft
FoxPro Driver (*.dbf)  and click Finish.
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3.  The ODBC Microsoft FoxPro Setup dialog box appears.
Type the name that identifies the data source, such as
“Employees List”.

4.  Description field: An optional description of the data in the
data source; for example, “Hire date, salary history, and current
review of all employees.”

5.  Choose the correct version of your FoxPro database
(FoxPro 2.0, 2.5 or 2.6)

6.  Disable the Use current Directory check box. Click the
Select… button and browse to the database you want to
connect.

7.  For more information on Select Indexes and Options>> see
Microsoft documentation

8.  Click OK to confirm all settings and end your ODBC
session clicking the OK button in the ODBC Data Source
Administrator dialog box. You are back to the ODBC Source
Selection dialog box.

¨   How to Select the MS FoxPro data source:

1.  Click the Refresh button in the ODBC Source Selection
dialog box. Browse through the available data source listing
until you find the name of the data source (for example:
“Employees List”) you just defined and click the Next button.
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2.  The Select table dialog box appears. Select the table you
want to work with and click finish. The database view appears
in a split-window next to the card view. Use the database
toolbar to navigate, add new, modify or delete records (see
section “The Card Software Database Functions” later in this
chapter).

Setup MS Paradox Data Source
¨  How to setup a MS Paradox data source:

1.  From the database menu click Connect. The ODBC Source
Selection dialog box opens. Click the ODBC Manager button.
The Microsoft ODBC Data Source Administrator dialog box
opens.

2.  Click the Add… button to setup a new data source. The
Create New Data Source dialog box appears. Select Microsoft
Paradox Driver (*.db) and click Finish.
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3.  The ODBC Microsoft Paradox Setup dialog box appears.
Type the name that identifies the data source, such as
“Members List”.

4.  Description field: An optional description of the data in the
data source; for example, “Entry date, salary history, and
current review of all members.”

5.  Choose the correct version of your Paradox database
(Paradox 3.x, 4.x or 5.x)

6.  Disable the Use current Directory check box. Click the
Select… button and browse to the database you want to
connect.

7.  For more information on Options>> see Microsoft
documentation
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8.  Click OK to confirm all settings and end your ODBC
session clicking the OK button in the ODBC Data Source
Administrator dialog box. You are back to the ODBC Source
Selection dialog box.

¨  How to Select the MS Paradox data source:

1.  Click the Refresh button in the ODBC Source Selection
dialog box. Browse through the available data source listing
until you find the name of the data source (for example:
“Members List”) you just defined and click the Next button.

2.  The Select table dialog box appears. Select the table you
want to work with and click finish. The database view appears
in a split-window next to the card view. Use the database
toolbar to navigate, add new, modify or delete records (see
section “The Card Software Database Functions” later in this
chapter).

Setup MS Text Data Source
Text files (*.asc, *.csv, *.tab or *.txt) are ASCII text files with
data sets in individual lines and fields seperated by comma,
tab or custom delimiters. These files can be created by word
processor, database, text editor and other applications.
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Before connecting the card layout with a text file you need to
establish a connection between the Card Software and the
text file. This connection is handled by the MS Text Driver (or
any other driver for *.csv and *txt files), which must be
configured in a way that it recognizes the file you want to call.

¨  How to setup a MS Text data source:

1.  From the database menu click Connect. The ODBC Source
Selection dialog box opens. Click the ODBC Manager button.
The Microsoft ODBC Data Source Administrator dialog box
opens.

2.  Click the Add… button to setup a new data source. The
Create New Data Source dialog box appears. Select Microsoft
Text Driver (*.csv, *.txt)  and click Finish.
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3.  The ODBC Microsoft Text Setup dialog box appears. Type
the name that identifies the data source, such as “Pupils List”.

4.  Description field: An optional description of the data in the
data source; for example, “Entry date, school history, and
current review of all pupils.”

5.  Disable the Use current Directory check box. Click the
Select… button and browse to the file you want to connect.

6.  Click the Options>> button to define the text file format. It
lists the filename extensions of the text files on the data source.
To see all files in the directory, select the Default (*.*)  check
box. To find only files with certain extension, clear the Default
(*.*)  check box and add each extension you want to see. The
extension must use the format *.xxx. To remove an extension,
highlight the extension in the Extensions list and click the
Remove button.
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7.  Click the Define Text Format... button, which enables you
to specify the schema for individual tables in the data source
directory. In the tables section select the table you want to
access, enable Column Name Header, if the first line of your
text file contains a header and define the corresponding
delimiter. In the columns section you can edit the format of
each column of the selected table. Set the character definition
to ANSI (Windows) or OEM (DOS). OEM specifies a non-
ANSI character set. Press the Guess button to verify the
column names (F1, F2…etc if you disable the column name
header check box)
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8.  Click OK to confirm all settings and end your ODBC
session clicking the OK button in the ODBC Data Source
Administrator dialog box. You are back to the ODBC Source
Selection dialog box.

¨  How to Select the MS Text data source:

1.  Click the Refresh button in the ODBC Source Selection
dialog box. Browse through the available data source listing
until you find the name of the data source (for example: “Pupils
List ”) you just defined and click the Next button.

2.  The Select table dialog box appears. Select the table you
want to work with and click Finish. The database view appears
in a split-window next to the card view. Use the database
toolbar to navigate, add new, modify or delete records (see
section “The Card Software Database Functions” later in this
chapter).

Common Errors:
1.  Decimal separator and text file delimiter are matching: The
automatic setting of the decimal separator during Windows
installation, defines a comma (,) as decimal separator for most
of the European countries. As the CSV file delimiter is a comma



124 Card Software User Manual

(,) as well, the text driver gets confused. Open Regional
Settings from the Windows Control Panel and change the
Decimal Symbol (to be found in the number menu) to a dot (.).

2.  Trying to edit a file from within the Card Software, while file
is open. Returns ‘Failed to make a SQL connection to file.

Setup MS Visual FoxPro Data Source
¨   How to setup a MS Visual FoxPro data source:

1.  From the database menu click Connect. The ODBC Source
Selection dialog box opens. Click the ODBC Manager button.
The Microsoft ODBC Data Source Administrator dialog box
opens.

2.  Click the Add… button to setup a new data source. The
Create New Data Source dialog box appears. Select Microsoft
Visual FoxPro Driver and click Finish.
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3.  The ODBC Microsoft Visual FoxPro Setup dialog box
appears. Type the name that identifies the data source, such
as “Employees List”.

4.  Description field: An optional description of the data in the
data source; for example, “Hire date, salary history, and current
review of all employees.”

5.  Choose between Visual FoxPro database (*.dbc) or Free
Table directory

6.  Click the Browse… button and choose the database you
want to connect.

7.  For more information on Options>> see Microsoft
documentation.
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8.  Click OK to confirm all settings and end your ODBC
session clicking the OK in the ODBC Data Source
Administrator dialog box. You are back to the ODBC Source
Selection dialog box.

¨   How to Select the MS Visual FoxPro data source:

1.  Click the Refresh button in the ODBC Source Selection
dialog box. Browse through the available data source listing
until you find the name of the data source (for example:
“Employees List”) you just defined and click the Next button.

2.  The Select table dialog box appears. Select the table you
want to work with and click Finish. The database view appears
in a split-window next to the card view. Use the database
toolbar to navigate, add new, modify or delete records (see
section “The Card Software Database Functions” later in this
chapter).

Working with N5 Database Interface
After connecting successfully to a database, the selected table
is displayed in a split window next to the card design area. To
access the record information of a column you have to create
Card Software objects and connect them with the database
fields.
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How to link database fields with the card layout:
¨  Linking a Text Object

1.   Open a text object and select ODBC Source as Variable
Source.

2.   The Source ODBC Source Selection dialog box appears.
Select the column which contains the records you want to
appear in your text object and click Finish.

3.      Edit the font properties you want and confirm clicking OK.
4.   In the card work area resize, if necessary, the selection

rectangle of the text box in a way that makes the largest
record of your column fit inside.
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5.    Save your card layout. Your card and the database are
connected. Whenever you’ll open your card, the database
automatically will be found and opened as well.

Note: The selection rectangle of the text box remains always
visible to indicate the database connection, but won’t be
printed.

¨  Linking an Image Object

There are two forms image information is stored in a database.
Either the image is part of the database itself, stored in an
image field (ODBC, point to image field), or the complete path
directory of an image field is stored in an text field, like
c:\images\001.bmp (ODBC, point to image file). The Card
Software supports multiple image field and/or image file linking.

1.     Open an image object and select  Image Source.
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2.     The Source Image Properties dialog box appears. Choose
either ODBC, point to image field or ODBC, point to image
file. Select the column which contains the information of
your image and click Finish.

3.   Confirm the Source Image Properties, clicking OK . In the
image Object dialog box, choose the options (rotation,
keep aspect, protected) you want to apply and click OK .

4. In the card work area resize, if necessary, you can resize
the image with the mouse.

5. Save your card layout. Your card and the database are
connected. Whenever you’ll open your card, the database
automatically will be found and opened as well.

¨  Linking a Bar Code Object

1.   Open an bar code object and select ODBC Source as
Variable Source.
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2.    The Source ODBC Source Selection dialog box appears.
Select the column which contains the records you want to
appear in your bar code object and click Finish.

3.      Set the Bar Code Object Properties you want to apply, and
confirm clicking OK .

4. In the card work area, if necessary, you can resize the bar
code with the mouse.

5. Save your card layout. Your card and the database are
connected. Whenever you’ll open your card, the database
automatically will be found and opened as well.
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¨  Linking a PDF Symbol Object

1.    Open a PDF symbol object and select ODBC Source as
Variable Source.

2.    The Source ODBC Source Selection dialog box appears.
Select the column which contains the records you want to
appear in your PDF symbol object and click Finish.
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3.     Set the PDF symbol Object Properties you want to apply,
and confirm clicking OK .

4. Save your card layout. Your card and the database are
connected. Whenever you’ll open your card, the database
automatically will be found and opened as well.

¨  Linking a Magnetic Code Object

1.     Open a Magnetic Code object and select for the track(s) (1
to 3) you want to encode ODBC Source as Variable Source.

2.    The Source ODBC Source Selection dialog box appears.
Select the column which contains the records you want to
encode in each track and click Finish.
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3.   Save your card layout. Your card and the database are
connected. Whenever you’ll open your card, the database
automatically will be found and opened as well.

The Card Software Database Functions

Editing a Database
· To add a new record to your database select Add from

the database menu. You also can click the Add Record
button at your database toolbar.

· Edit the record and save it clicking the Save Record
button at your database toolbar.

· To delete a record select Delete from the database menu.
You also can click the Delete Record button at your
database toolbar.

Quick Editing
· The End of Fields dialog box is a Card Software concept,
which offers the possibility to customize how to proceed with
an image field and which database functions you want to
perform. The End of Fields dialog box appears after you press
Enter in the last record field and allows you to configure and
decide what you want to do next.
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¨   How to proceed with the Image Field:

If your database has two or more image fields, select the field
you want to configure.

The command Open From File lets you select an image from
a local or network disk.

Select Acquire, if you perform the image acquisition using
TWAIN interface.

Paste copies a bitmap from the Windows Clipboard.

Select Freeze if you are using the MCI interface to transform
the analog signal in digital data.

The Operations section allows you to choose the functions
you want to perform:

Save, saves the current record.

Print , prints the current record. Make sure the settings in the
print dialog box are correct.

New Record, display a new blank record with all fields.

Multiple combinations are allowed.

Moving between Records

· To move to the first record, select Move First from the
database menu. You also can click the Move First button
at your database toolbar.

· To move to the last record, select Move Last from the
database menu. You also can click the Move Last button
at your database toolbar.
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· To move to the next record, select Move Next from the
database menu. You also can click the Move Next button
at your database toolbar.

· To move to the previous record, select Move Previous
from the database menu. You also can click the Move
Previous button at your database toolbar.

The Find Function
¨   Finding a record

1.   From the Database Menu, select Find Record. You also
can click the Find button at your database toolbar. The
Find in Field dialog box appears.

2.   Type the characters (normally names or numbers) you are
looking for in the Containing box, select the corresponding
field in the In Field box and click Find Next.

Note: Use the First Match , Previous and Next buttons to the
define the search direction. The First Match button searches
from the beginning of  the table and finds the fist record that
match the condition. The Previous button searches from the
current table position to the beginning of the table. The Next
button searches from the current table position to the end of
the table.
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The Query Function
¨   Working with Queries (Filters)

1. From the database Menu, select Query. You also can
click the Query button at your database toolbar. The Query
Database dialog box appears.

2. To find, for example, all clients, which start with letter P,
click the … button next to the field which contains your
clients names. Edit the query dialog box applying O in the
Greater than box and Q in the Less than box.

Tip : You can achieve the same result typing P in both, the
Greater Than and Less Than box and enabling the Exact Match
check box.

Note: If you click the Match Case check box the Card Software
will find only the exact match(es) of what you typed in the
Find What box. The Find Function is case sensitive!

3.   If no records match or the end of the database is reached
the Card Software displays the message: “Card Software
has finished searching the table. No more records found”.
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3. You may set further comparison condition for other fields.
4. If you are familiar with SQL commands you can edit directly

the command string for your query, clicking the SQL
button.

5. Click Submit to start the Query function.
6. If you need to know the number of records found, click

Properties from the database menu and enable the Record
Set Counter check box. The number of records is listed in
the box below.

Note: The Query function is not case sensitive!

7.   To access all records again, click the Clear button in the
Query Database dialog box.

Note: if you save a card after applying the Query function, the
queries performed are saved as well.

Database Interface Properties
Connection Time Out:  determines the period after which a
connection to a data source is interrupted (e.g.: if server is
down) and control returned to the Card Software.

Query Time Out: determines the period after which a query
to a data source is interrupted (e.g.: if server is down) and
control returned to the Card Software.

Prompt for Connection Information: Normally, communication
between the ODBC driver and a database is not visible for the
user. If the Prompt is enabled, it allows an ODBC driver to
interact with the user (e.g.. asking for login, password or
database directory)

Use ODBC Cursor Library: disable this check box only if
you are working with a powerful database engine like (SQL
Server, Informix, Oracle, etc.). It gives complete control to these
engines overriding ODBC drivers.
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Database View
Define View

The Card Software allows you to change the column sequence
of the displayed database. From the database menu, select
Define View or press the Define View button from the database
toolbar. Click on the field name you want to move and drop it
at the place you want.

Browse View

Click the Browse/Record button to change the database
display from Record View to Browse View. Use this function
to get a list of all available records. To browse quickly to a
certain record, double-click it (you must use its data in the
first column). The record and its fields is displayed in Record
View.

Allow data edition: check this box if you want to edit a database
from within the Card Software. Please note, that not all ODBC
drivers permit data edition.

Refresh Delay: determines the time that the Card Software
waits for to refresh the card view, after editing a field in your
database.

Trailing Decimals: allows you to specify the number of
decimal places for numeric floating print data.

Record Set Counter: if enabled the Card Software lists the
number of records of a database (or in a query) found.

Image Transfer Options: Controls image data transfer
between database and the Card Software bi-directionally.
Adapt the buffer size value to the average image size of  your
database. To reduce database size you can enable the
Compress Images check box. Images are compressed if greater
than the value determined in the corresponding box. If you
enable the Use Maximum Compression check box, the best
compression to be achieved is applied, but the Card Software
may need more time for this performance. The Card Software
image compression algorithm is a variant of the LZW algorithm.
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Database Image Properties
To open the database image properties dialog box right-click
the database image field. Image size, resolution and
compression ratio are displayed.

The Card Software Database Reports
The Card Software Database Report is an useful tool,
providing you to create, save and print a customizable listing
of your whole database or selections thereof.

Create Database Report
¨  Creating a new database report

 1. From the Database menu, select Reports or click the
Report button in the Database Toolbar. The Database
Report dialog box appears. Type the listing title. Select a
field you want in your report from the Database Field box
and click the Move Right button. You also can double-
click the field to move it to the Fields to Print box. To
deselect a field from the Fields to Print box, select it and
click the Move Left button. You also can double-click
the field to move it back to the Database Field box.



140 Card Software User Manual

Attention : Make sure that the sum of field characters to print
isn’t larger than the paper width, otherwise the print result
will be truncated. If you need you can reduce de display size
for a field, for that just enter a lower value in the Size of the
Database Report dialog box. You can also change the font
size.

2. Save your database report, clicking the Save button. The
Save As dialog box appears. Type a filename and click
OK.

3. Use eventually the Card Software Filter Functions to make
a selection of records.

4. To select the font style and size you want your report
printed with click the Font… button. The Font dialog
box appears. Make your choice and click OK .

5. Optionally you can change your Printer Setup. Click the
Print Setup… button and make your choices (page
layout, default printer, print to file, etc.) and click OK .

6. To print your report click the Print button in the Database
Report dialog box.

Attention : If you click the Close button without saving your
database report, the selection you made will be permanently
lost.
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Open a Database Report
¨  Open a database report

1. From the Database menu, select Reports. The Database
Report dialog box appears. Click the Open button. The
Open dialog box appears

2. Make your selection and click OK . The Database Dialog
box appears, containing the data of your saved report.

The Auto Print Function
The Auto Print concept is a powerful additional database/
print function which permits database edition and automatic
print on one or in different workstations. Information about
which cards (records)  were already printed is automatically
added to the database, the Card Software keeps track of the
printing process and only newly edited cards (records) will be
printed.

Preparing the Card Software for Auto Print

Prepare a Database for Auto Print

Plan the layout of the database to be used for auto print,
adding all fields you need to store the information you require.
Create one extra field (field type must be numeric or char),
which will store the information if cards (records) were printed
or not. This field may not be indexed ‘unique’. Make sure you
choose a database format which comes with an ODBC driver
permitting bi-directional editing (like dBase, Access, etc.). If
you need to use an already existing database, add one filed
which will contain the print information of the cards (records).
If you define an already existing field to contain these
information, all data in this field will be erased. The database
file must be shareable between different users (may not be
exclusive, read only, etc.).

Prepare Workstations

On the first workstation prepare all settings to edit the database
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you have prepared in step 1.  In the second workstation create
the card layout and link it to the database (as explained earlier
in this chapter). Make sure the Allow data edition check box
in the database interface properties dialog box is enabled.
Make sure the right printer/ribbon settings are defined (see
chapter 22, Appendix A “Printing and Ribbon”). Save the
card document.

Start Auto Print

1.    From the database menu select Auto Print… . The Auto
Print Configuration dialog box appears

2.     Define the Print Control Field. From the scroll down menu
select the control field you defined before in step 1. If  the
print control field is text type, it’s data will be replaced by
“* ” if the print process was performed correctly, otherwise
by “E”. If the print control field is numeric type, it’s data
will be replaced by “1” if the print process was performed
correctly, otherwise by “9”.

3.     Define a Guide field. Choose a field which identifies best
each card (record), like a field which includes a name, id-
number  or similar. Besides the print date and time its
contents is displayed in the Auto Print dialog box, helping
you to control the print process.

4.    Set  the Poll Delay. This value indicates the time (in
seconds) the Card Software will wait before refreshing
the database table. After refreshing the table all cards
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(records), which were not printed yet are sent to the printer.
5.      Create Icon on Desktop and Start when opened. Pressing

the Create Icon button will create an icon with a shortcut
to the Auto Print card document at your desktop. If the
start when opened check box is enabled, the Auto Print
process starts performing immediately.

6.     If   you want to apply a filter to the database click the
Query Filter button (see earlier in this chapter).

7.    Mark all as printed/not printed: These buttons allow to
change the information of the complete record set to
printed/not printed status.

8.      OK/Cancel. The OK button saves the Auto Print settings
and closes the Auto Print Configuration dialog box. Press
Cancel to leave the Auto Print dialog box without saving
any changes/settings.

9.   Start  Auto Print. The final step. Click this button  to
perform Auto Print on workstation 2. The Auto Print
dialog box appears

10.  Stop/Close:  Stops the Auto  Print function and   closes
the Auto Print dialog box

11.  Save History. Click this button if you want to save the
information displayed in the Auto Print dialog box as
*.txt file.
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11. Photo in PDF Symbol

The Card Software provides the possibility to encode the
information of an image or photo in your database into a PDF
symbol. The maximum size of an image, which still can be
encoded, is 80 x 80 pixels. If the height or width of an image is
larger than 80 pixels, its size will be recalculated to this value,
maintaining the image’s proportions.

Photo Encoding
¨  To encode an image into a PDF symbol

  1.Open or create the card and database with the image
you want to encode.

2. On the lower toolbar, click the PDF Symbol tool; the
pointer changes to a hand with the PDF icon.

3. Click on the card where you want to place a corner of the
PDF symbol. The PDF Symbol Properties dialog box
appears.
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4. Select ODBC Source as Variable Source. The Source
ODBC Properties dialog box appears.

5. Select the column, which contains the image you want to
encode.

6. Click OK  to close the Source ODBC Properties dialog
box. Edit the PDF Symbol Properties you want and Click
OK . The PDF symbol appears on the card.

Photo Reader
The Photo Reader is a security tool, which you can use in
combination with a PDF card reader to decode the image
information of a PDF symbol.

Setting up the Photo Reader
¨  To set up the Photo Reader

1. Open the Card Software Program Group. Click on the
Readpdf icon.

2. The PDF Photo Reader window appears.
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3. Click Port Setup…. The Serial Port Settings dialog box
appears.

4. Select the port your PDF card reader uses (normally
COM2). Check the correct baud rate and data format of
your computer system. See your PDF Card Reader manual
for the correct settings. Click OK  to confirm your
settings.
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Reading a Photo
¨  Using the Photo Reader

1. Start the Photo Reader
2. Read the card with your PDF card reader. The encoded

image appears (black & white) in the PDF Photo Reader
window.

3. To proceed click Clear Image and repeat step 2. To end
the PDF Photo Reader session click Exit.

Tip:  You can toggle between the Card Software and PDF Photo
Reader pressing Alt + Tab.

Limitations:
The PDF417 symbol used by the Card Software may contain
up to 64K of data. Anyhow, the photo encoding process is
limited to 1,5K of data, which composes a PDF symbol still
fitting onto the card.  Therefore the Card Software uses 3
methods of data compression:

·   Colored images are converted to grayscale.

·   The maximum size of an image, which still can be encoded,
is 80 x 80 pixels. If the height or width of an image is larger than
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80 pixels, its size will be recalculated to this value, maintaining
the image’s proportions.

·   The Card Software uses the JPEG logarithm, one of the most
powerful data compression formats, to reduce image size to
make it still encodable.

·   Use uniforme, highly contrasted backgrounds when
acquiring an image. Try to reduce the image size to a still
acceptable minimum.
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12. Image Acquisition

Besides opening images from a file, the Card Software allows
direct image acquisition in three ways: using the TWAIN
interface, the VfW (Video for Windows) interface or the serial
port, combined with a proper application.

The Card Software supports the use of any camcorder and
VCR, with video output as well as digital cameras to acquire
images.

Image Sources
Open from file: Allows to browse to an image file and open it

Open from File at Print Time: Allows to browse to an image
file and open it at print time

Scan: Scans a new image using a defined Twain driver

Scan at Print Time: Scans a new image using a defined Twain
driver at print time

Paste: Pastes an image from the Windows clipboard

Point to Image File: links to an image, which location (path) is
stored in a related database field

Point to Image Field: links to an image, which is stored in a
related database image field

Video for Windows: Acquires an image using the VfW
interface (see later in this chapter).

Image Transfer with Video for Windows (VfW)
Advanced Feature

VfW is the latest standard for image acquisition, an evolution
of the older MCI-concept. Camcorders or VCRs produce an
analog image dataflux, which is transferred as analog signal
from the camera to the capture card and from here to the video
card using the PCI-bus. Your operating system must support
directX (image-information crosses directly to the capture card)
and direct Draw (image information is directly displayed on
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screen). The image information is transformed intodigital data
at freeze-time (when captured).

Digital cameras store images on a (floppy) disk as digital
information, which can be transferred to the PC using the
serial port and a proper application or the Twain interface.
Some digital cameras allow also the use of a video capture
board (e.g. Canon Ion or Canon Powershot) or the use of a
proper video capture board..

Capturing Images
Using the TWAIN interface

Twain is an industry-standard protocol for exchanging
information between application software (like this Card
Software) and image capture devices such as scanners or
camcorders.

After installing a TWAIN driver, you must define, which
TWAIN driver the Card Software shall use. Simply use the
command Video Sources from the Options menu. To select a
TWAIN driver as default TWAIN source click the
corresponding Setup button. In the  Select Source dialog box
choose your Twain driver from the list.

Click the image button from the Drawing toolbar or use the
command Image Object from the Drawing Tools menu. Select
the area, which the image shall occupy later on the card. The
image object dialog box appears. Click the Scan… button. A
driver specific preview dialog box opens, displaying the
captured area. Movements are displayed depending on the
transfer speed of the capture board. Make your settings and
capture (grab) the desired image. The image tools dialog box
appears. Make your changes as described in chapter 5, section
“Image Tools”.
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Using the Video for Windows (VfW) interface
The 32 bit Card Software supports now Video for Windows.
VfW is the latest standard for image acquisition, an evolution
of the older MCI-concept. Cheap and powerful video capture
cards are available on the market, primarily designed for
Internet Video Conferences, but perfectly suitable for image
acquisition with the Card Software.

Most of these capture cards are using Brooktree Bt848 chipset,
which tackles the tough challenges of blending and displaying
the complex video, graphics and text data streams embedded
within Intercast video and broadcast transmissions. It
supports image resolutions up to 768 x 576 (full PAL
resolution).

Image transfer occurs as analog signal from the camera to the
capture card and from here to the video card using the PCI-
bus. Your operating system must support directX (image-
information crosses directly to the capture card) and direct
Draw (image information is directly displayed on screen).

Before you can use Video for Windows with the Card Software
you must set the video source. Use the Video Source
command from the Options menu. In the appearing dialog box
click the Setup button for the Video for Windows driver.
Choose your VfW driver. The Source button calls a driver
specific dialog box for the overlay control settings (saturation,
brightness, contrast, etc.). The Format button calls a driver
specific dialog box for the video format settings (image format,
dimensions, etc.).

Choose between Overlay or Preview video mode. Both modes
display in a reserved space the image information, coming
from the camera. Besides this transfer is digital using the PCI-
bus, images don’t occupy a processor power and space on
your hard disk until freeze-time (capturing and transforming
the image into digital). The Overlay video mode displays image
information in real time. The Preview mode is recommendable,
if your capture card or it’s driver causes conflicts in overlay
mode. In Preview mode the Card Software takes control over
image display, but it’s not in real-time.
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Life Video Acquisition
Advanced Feature

¨  Life video acquisition on your card work area
1. Use the Image button from the drawing toolbar to open

the image object dialog box.
2. Choose Image Source as variable source and Video in

the source image properties dialog box. If you want to
call automatically the image tools workspace, enable the
corresponding check box.

2. After eventually performing changes with the image tools
click the OK button in the Image Objekt dialog box.

4. The image appears on your card workspace. Double-click
on the image to toggle between freeze and unfreeze.

¨  Life video acquisition on your database photo field
1. Click inside the database photo field. A shortcut menu

appears. Select Video. The analog image appears inside
the database photo field.

2. Freeze the image (stop the image movement and transform
it in bitmap) with a double-click over the image. To
unfreeze the image double-click again. To toggle fast
between freeze and unfreeze press F8.

Using the serial port
Some models of digital cameras come with a proper software,
which reads the images from the digital camera’s floppy disk
using the serial port. Save the image(s) in any of the file formats
used by the Card Software (*.bmp, *.tif, *.tga, *.pcx, *.jpg) .

Use the image objects tool and choose open from file to acquire
the desired image.

The Test button calls a dialog box, which displays the captured
images, depending on the settings above. Click the OK  button,
to confirm all settings.
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13. Logins and Passwords

Administrator Login
¨   Edit Administrator Logins

1. From the File menu, select Logins. The Logins dialog box
appears.

Advanced Feature

· The Card Software provides customizable security and
access level. Whenever you start the Card Software the
Login Dialog box appears, if the Disable Logins check
box is cleared.

· The default login and password is admin. Login means
an access level, password the access authorization.
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2. Clear the Disable Logins check box to activate this secu-
rity feature.

3. Select Administrator  and click the Edit button. The Edit
User Properties dialog box appears.

4. Type a login of your choice. Proceed equal with your
Card Software password and confirm it. The database
login and password give access authorization to an ex-
ternal database of yours. Make sure all areas are selected.

Create User Login
¨  Add User Login

1. From the File menu, select Logins. The Logins dialog box
appears. Click the New button. The New User dialog box
appears.
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2. Edit user name, login and password, as well as Database
login and password, if necessary.

3. Depending on what kind of job you want your employee
may perform select one or multiple access areas.

Access Areas
· No area selected: The following operations are available

for any access area:
- File Menu: open, close cards, exit program

- View Menu: turn on/off database window, obtain printer
info, zoom in/out, view front/back side

- Window Menu: cascade, tile, arrange icons, arrange
card&database window

- Help menu: contents, using help, about the Card
Software

· Administration:  permits to edit logins and passwords.
· Design: permits all card editing functions, including

magnetic encoding and chip card setting.
· Card Document Printing: permits to operate all print

functions.
· Modifying Defaults: permits to set all default options.
· ODBC Data Fields Edition: permits to edit all databases

accessible through database login and password.



156 Card Software User Manual

14.  Menu Commands

This section summarizes the commands available in the Card
Software menus. Depending on the Card Software version/
edition some menu items may be not available.

Main Window
The File Menu

New

Creates a new card file.

Open...

Opens an existing card file.

Close

Closes the active card file

Save

Saves the card to a disk file.

Save As...

Saves the card, with a name you specify, to a disk file.

Card Setup...

Selects portrait or landscape orientation.

Card Print...

Displays the Card Print dialog box to print and/or encode a
magnetic stripe/chip.

Printer Setup...

Displays the Printer Setup dialog box to specify a chosen
printer.

[Recently used File List]

Provides a means to quickly open a card you recently worked
with. The names of the last (up to four) used files will be
displayed. Click on the desired file name and the card will be
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opened and displayed.

Logins (Advanced Feature)

Configuration of user login, password and area access.

Batch Print File Management (Advanced Feature)

Batch print file configuration, preview and printing.

Exit

Exits the Card Software program.

The Edit Menu
Cut

Deletes the selected object and places it on the Clipboard so
you can paste it elsewhere.

Copy

Makes a copy of the selected object and places it on the
Clipboard.

Paste

Pastes the object from the Clipboard onto the card work area.
A copy of the pasted object remains on the Clipboard until it
is replaced by another Cut or Copy command.

Use Private Clipboard

Selects the Card Software private clipboard. The private
clipboard allows the transfer of all Card Software objects
maintaining their properties.

Use Windows Clipboard

Selects the standard Windows clipboard. The Windows
clipboard transfers Card Software objects as bitmaps.

Delete

Deletes the selected object completely without putting a copy
on the clipboard.

Select All

Selects all the objects on the card.
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Move To Front

Moves the selected object to the front of a stack of other
objects.

Move To Back

Moves the selected object to the back of a stack of other
objects.

Item List...

Displays a list of all objects that can be edited or deleted.

Duplicate Item

Makes a copy of an object and places it slightly offset and
overlapping from the original. Unlike the Copy command,
Duplicate doesn’t place a copy of the object on the clipboard.

The View Menu
Toolbars…

Let you show or hide any of the individual Card Software
Toolbars.

Card Info...

Displays the full card document information of the active card.

Zoom In

Magnifies the size of the card depicted on the screen.

Zoom Out

Reduces the size of the card depicted on the screen.

Guidelines

Toggles the display of the guidelines that mark the edges of
the printable area of the card.

Front Side

Displays the front side of the active card.

Back Side

Displays the back side of the active card.
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The Drawing Tools Menu
Selector

Activates the Selector tool, used to select objects.

Line Object

Activates the Line tool for drawing horizontal or vertical lines.

Rectangle Object

Activates the Rectangle tool for drawing rectangles of variable
size.

Filled Rectangle Object

Activates the Filled Rectangle tool for drawing filled rectangles
of variable size.

Text Object

Activates the Text tool for editing text.

Image Object

Activates the Image tool for editing images.

Barcode Object

Activates the Barcode tool for editing bar code symbols.

PDF Symbol Object

Activates the PDF Symbol tool for editing PDF symbols.

Magnetic Code Object

Activates the Magnetic Code tool for encoding magnetic
stripe cards.

Chip Card Options

Activates the Chip Card Options for setting the parameters of
a chip card processing application

Overlay Clipping...

Defines the size, shape and placement of the overlay coating.

The Options Menu
Change Default Line Width...

Changes the default line width for all drawn objects that contain
lines.
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Change Default Font...

Changes the default font for all text objects.

Video Sources (Advanced Feature)

Selects the default Twain and Video for Windows source.

Activate Protected Objects

Toggles the read only property of an object.

Grid Settings...

Selects the horizontal and vertical spacing of the layout grid
and toggles the snap-to the grid option.

Show Grid

Toggles the display of the layout grid.

Snap to Grid

Toggles the snap to grid option.

Keep Drawing Tool

Keeps the current drawing tool selected.

Front & Back

Configure the front and back layer switching options.

The Tools Menu
Printer Tools...

Allows you to setup the current printer properties.

Fit Object to Card

Expands the selected rectangle or image to fill the full size of
the card.

The Database Menu
(Advanced Feature)

Connect

Connects to a database.

Disconnect

Disconnects from the database.
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Browse View

Toggles between the Browse/Record View.

First

Moves to the first record.

Previous

Moves to the previous record.

Next

Moves to the next record.

Last

Moves to the last record.

Find …

Finds data in the current table.

Query …

Sets a search criteria.

Add

Adds a new record.

Delete

Deletes the current record.

Save

Saves the current record.

Reports

Creates and prints database reports.

Properties

Allows to configure the database interface properties.

Define View

Allows to define the database view.

Auto Print …

Sets and activates the auto print function.
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The Window Menu
Cascade

Arranges open card windows so that they overlap and the
title bar of each window is displayed.

Tile

Arranges open card windows horizontally with no over-
lapping.

Arrange Icons

Arranges icons.

 [Card window list]

Provides a means to quickly display any open card and
database or batch print (Advanced Feature) window. The
names of all open windows will be displayed. Click on the
desired file name to activate the window.

The Help Menu
Contents

Displays the Card Software Help contents.

Using Help

Displays information about using the Card Software help sys-
tem.

About Card Software...

Displays the Card Software version serial number and copy-
right information .

Batch Print File Manager Window
(Advanced Feature)

The File Menu
Close

Closes the Batch Print File Manager window.
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The Window Menu
Cascade

Arranges the windows in a cascade view.

Tile

Arranges all open windows in a tiled view.

Arrange Icons

Arranges icons.

 [Card window list]

Provides a means to quickly display any open card and
database or batch print (Advanced Feature) window. The
names of all open windows will be displayed. Click on the
desired file name to activate the window.

The View Menu
Back

Switchs between front and back view.

The Log Menu
First

Goes to the first card document.

Previous

Goes to the previous card document.

Next

Goes to the next card document.

Last

Goes to the last card document.

Print

Prints the cards according to the status checked on the Status
to Print dialog box. Supplies status Error to a card, if occurred.

Status

Sets the card document status To Print, Error, Printed or Held.
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Image Tools Window

The File Menu
New

Creates a new card file.

Open...

Opens an existing card file.

Close

Closes the active card file

Save

Saves the card to a disk file.

Save As...

Saves the card, with a name you specify, to a disk file.

Card Setup...

Selects portrait or landscape orientation.

Card Print...

Displays the Card Print dialog box to print and/or encode a
magnetic stripe/chip.

Printer Setup...

Displays the Printer Setup dialog box to specify a chosen
printer.

Scan Image

Selects a source for image acquisition or starts the image ac-
quisition process.

[Recently used File List]

Provides a means to quickly open a card you recently worked
with. The names of up to four recently used files will be dis
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played. Click on the desired file name and the card will be
opened and displayed.

Logins (Advanced Feature)

Configuration of user login, password and area access.

Batch Print File Management (Advanced Feature)

Batch print file configuration, preview and printing.

Exit

Exits the Card Software program.

Edit Menu
Undo

 Reverses the last command performed and returns the image
to its previous state. Quickly perform this command clicking
the corresponding tool button.

Keep Ratio

The tracker rectangle maintains its previously defined height
and width relation.

Image Menu
Adjust Colors

The command Contrast decreases or increases an image
contrast by moving the RGB (red , green, blue) tracker bar.
Unlock the control field Lock to change values for RGB
separately. Quickly perform this command clicking the
corresponding tool button. The command Brightness
decreases or increases image brightness by moving the RGB
tracker bar. Unlock the control field Lock to change values for
RGB separately. Quickly perform this command clicking the
corresponding tool button.

Effects

The command Blur  decreases the contrast between pixels,
the image appears smoother. Sharpen increases the contrast
between pixels, the image appears more focused. Sharpen
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More has the same effect, but with higher intensity. High
Contrast lets you set a threshold value to kodalith an image

Grayscale

Converts the image from color to gray

Remove Noise

Removes graining by averaging areas of the image.

Crop

This command is only available, after selecting an image area
with the select button from the image tools toolbar. Define the
area you want to keep by dragging and resizing the selection
rectangle. Then use the command Crop from the Image menu.

Resize

Select the desired value, then click Resize.

Kodalith

Displays the Input Values dialog box. Enter the desired value,
then click OK .

Exit Menu
Exit

Closes the Image Tools dialog box, saving all settings made.

Cancel Menu
Cancel

Closes the Image Tools dialog box, not saving any settings
made.
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15. Toolbars and Tools

This section provides a summary of the Card Software tools.

The Card Software Tools
“Tools” is the term used to describe commands that are avail-
able with a single mouse click on a command button.

The command buttons for all the Card Software tools are ar-
ranged in various “Toolbars”. Tooltips which explain the func-
tion of each button are displayed if you move the mouse
pointer slowly over the buttons.

The Standard Toolbar
The Standard Toolbar contains command buttons for
accessing the commands in the File menu, the Edit menu and
Help menu.

The tools of the Standard Toolbar are:

 New - Creates a new card file.

 Open - Opens an existing card file.

 Save - Saves the card to a disk file.

 Print - Displays the Card Print dialog box to print and/or
encode the active card.

 Delete - Deletes the selected object completely without
putting a copy on the Clipboard.

 Cut -Deletes the selected object and places it on the
Clipboard so you can paste it elsewhere.

 Copy - Makes a copy of the selected object and places it
on the Clipboard.

 Paste - Pastes the object from the Clipboard onto the
card. A copy of the pasted object remains on the clipboard
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The Drawing Toolbar
The Drawing Toolbar contains command buttons for
accessing the commands in the Draw menu.

The tools on the Drawing Toolbar are:

 Selector - Used to select an object.

 Line - Draws horizontal or vertical lines.

 Rectangle - Draws a rectangle of variable size.

 Filled Rectangle - Draws a filled rectangle of variable
size.

 Text - Defines a text field.

 Image - Draws a frame to contain an image.

until it is replaced by another cut or copy command.

 Duplicate - Makes a copy of an object and places it slightly
overlapping the original. Unlike the Copy command, Duplicate
doesn’t place a copy of the object on the Clipboard.

 Move to Front - Moves the selected object to the front of
a stack of objects.

 Move to Back - Moves the selected object to the back of
a stack of objects.

 Front Side - Sets the view to the front side of the card.

 Back Side - Sets the view to the back side of the card.

 About - Displays the Card Software version, serial number
and copyright information.

 Topical Help - Displays help information about a command
or window object.
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 Barcode - Draws a bar code symbol.

 Barcode PDF - Draws a bar code PDF symbol.

 Magnetic Encoder - Encodes magnetic stripe cards with
fixed or variable data.

 Chip Card Encoder - Sets parameters for an external chip
processing application.

 Overlay Clipping - Defines the size, shape and placement
of the overlay coating.

The Database Toolbar
(Advanced Feature)

The Database Toolbar contains command buttons for
accessing the commands in the Database menu.

The tools on the Database Toolbar are:

 Browse View - Toggles between the Browse and Record
View.

 Connect - Connects to a database.

 Disconnect - Disconnects from the database.

 First - Moves to the first record.

 Previous - Moves to the previous record.

 Next - Moves to the next record.

 Last - Moves to the last record.

 Find ...- Finds data in the current table.
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The Batch Print Toolbar
The Batch Print Toolbar contains command buttons for
accessing the commands in the View and Log menus.

The tools on the Batch Print Toolbar are:

 To Print  - Sets the Status To Print to a card document.

 Error - Sets the Status Error to a card document

 Printed - Sets the Status Printed to a card document

 Held - Sets the Status Held to a card document

 Front/Back View - Toggles between both sides of the
card.

 First - Moves to the first card document.

 Previous - Moves to the previous card document.

 Next - Move to the next card document.

 Query ...- Sets a search criteria.

 Add - Adds a new record.

 Delete - Deletes the current record.

 Save - Saves the current Record.

 Reports - Creates and prints database reports.

 Properties - Allows to configure the database interface
properties.

 Define View - Allows to define the database view.
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 Last - Move to the last record.

 Print - Prints cards according to the status checked on
the status to print dialog box.

 Close - Closes the current Batch File

The Image Tools Toolbar
The Image Tools Toolbar contains a collection of command
buttons to enhance the selected image.

The tools on the Image Tools Toolbar are:

 Arrow:  Deselects Zoom and Crop tool

 Select: The mousepointer changes to a fine cross. Define

the area you want to crop by dragging and resizing the selection
rectangle.

 Zoom: Select this tool to zoom in (by leftclicking) or out

(by rightclicking).

 Undo: Reverses the last command performed and returns

the image to its previous state.

  Brightness and Contrast: Fast access to adjust

image colors.
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16. Keyboard Shortcuts

This section lists the keyboard shortcuts available for many
of the Card Software commands.

Shortcut Keys
Use the following key combinations to execute the command
listed next to it. When the keys are connected by a +, it means
to press both keys at the same time.

General
Ctrl+F4  - Close. Closes the active Card/Batch Print Window.

Ctrl+F6  - Next. Moves to the next Card/Batch Print Window.

Card Work Area
Ctrl+N  - New. Creates a New card file.

Ctrl+O  - Open. Opens an existing card file.

Ctrl+S  - Save. Saves the card to a disk file.

Ctrl+P  - Print. Displays the card Print dialog box to print and/
or encode a magnetic strip/chip card.

Ctrl+X - Cut. Deletes the selected object and places it

on the Clipboard so you can paste it elsewhere.

Ctrl+C  - Copy. Makes a copy to the selected object and places
it on the Clipboard.

Ctrl+V  - Paste. Pastes the object from the Clipboard onto the
card. A copy of the pasted object remains on the Clipboard
until it is replaced by another Cut or Copy command.

Del - Delete. Deletes the selected object completely without
putting a copy on the Clipboard.

Ctrl+A  - Select All. Selects all the objects on the card.

Ctrl+F  - Move to Front. Moves the selected object to the
front of a stack of objects.
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Database Window
(Advanced Feature)

To enable these shortcuts you must focus to the database
view, simply clicking into one of the database fields.

F5 - Paste. Pastes an image from the clipboard to the database
image field.

F6 - Open from File. Opens an image file from disk

F7 - Acquire. Acquires an image

F8 - Freeze. Freezes an image

Ctrl+B  - Move to Back. Moves the selected object to the
back of a stack of objects.

Ctrl+I  - Item List. Displays a list of all objects that can be
edited or deleted.

Ctrl+D  - Duplicate. Makes a copy of a n object placing it
slightly overlapping  the original. Unlike the Copy command,
Duplicate doesn’t place a copy of the object on the Clip-
board.

+  - Zoom in. Magnifies the size of the card depicted on the
screen.

–  - Zoom out. Reduces the size of the card depicted on the
screen.

Ctrl+L  - Guidelines. Toggles the display of the guidelines
that mark the edges of the printable area of the card.

Ctrl+H  - Snap to Grid. Toggles the Snap to Grid option.

Ctrl+1 - Front side. Displays the front side of the active card.

Ctrl+2  - Back side. Displays the back side of the active card.

Ctrl+G  - Show grid. Toggles the display of the layout grid.

Ctrl+K  - Keeps the current drawing tool.

Ctrl+Shift+F - Fit LOGO to card. Expands the selected image
to fill the full size of the card.
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17. About Barcodes

This section provides information on bar codes and their use
with the Card Software.

Bar Codes
Introduction

A bar code is a machine-readable symbol representing human-
readable information.

The information represented can be alpha or numeric only,
limited alphanumeric, or the full character set. The human-
readable alpha or numeric characters are represented in the
bar code symbol by a series of varying width vertical lines
(called bars) and spaces. Bars and spaces together are elements.

An element can be a wide black bar or white space, or a narrow
black bar or white space. Each element is assigned a binary
value of either “1” or “0”. To represent the necessary character
in the bar code, the elements must follow a precise sequential
order as part of a group.

Scanning is the process of acquiring or “reading” the
information encoded in a bar code symbol. To read the
information contained in a bar code symbol, a scanning device
such as a light pen is moved across the symbol from one side
to the other. As the scanning device is moved across the
symbol, the width pattern of the bars and spaces is translated
back into the original information. Bar code is an optical
technique because information is scanned using light that
reflects off dark or light regions of the symbol.
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Bar Code Standards
The number of elements and their order is defined by the bar
code standard used.

There are many bar code standards to choose from and each
standard was developed for the specific data requirements of
various industries. Each standard dictates the maximum
number of characters a symbol can represent, as well as what
kind of data is represented.

Consequently, the number of characters in the information
field and the type of information represented will play a role in
which bar code standard can be used.

Other considerations include what standard(s) trading
partners use, the scanning environment (type of scanner,
printable area, symbol durability, etc.) and the symbol printing
requirements.

Symbologies
Symbology is the term used to describe the rules specifying
the way data is encoded into the elements (bar and space
widths) that comprise a bar code standard. Various
characteristics further describe the symbology. Some of these
characteristics are described below.

· The Character Set is the range of data characters that
can be encoded into a given symbology. Numeric
symbologies only encode numbers; others can encode
numbers and letters and are called alphanumeric.

· The Symbology Type can be either discrete or continuous.
In a discrete type, each character stands alone and can
be decoded separately from adjacent characters. A
continuous type has no inter-character gaps; the end of
one character is the start of the next. This results in a
higher density symbology than the discrete type, allowing
more information to be encoded in less space, resulting
in a smaller bar code symbol.

· The Number of Element Widths is either two (wide and
narrow) or multiple. Multiple element width symbology
is usually the higher density continuous type.

· The symbology Length can be fixed or variable.
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· Density describes the amount of data that can be encoded
in a given unit of length.

· A symbology is said to be Self Checking if a single
printing defect will not cause a character to be transposed
into another character in the same symbology.

· A Start Code is a particular pattern of lines and spaces
indicating the beginning of the bar code symbol. A Stop
Code indicates the end of the symbol. The start and stop
codes are sometimes also used to indicate the scanning
direction. In the most common symbology, Code 39, the
start and stop codes are asterisks.

· The Check Character is used by the scanner to validate
that the correct data has been decoded. It is placed in a
predetermined position and its value is based on a
mathematical relationship of the other characters in the
symbol. A Check Digit is a check character that can
assume only numeric values.

· A Bi-directional  symbology can be successfully scanned
in either direction. Almost all symbologies in use today
are bi-directional.

Card Software Symbologies
The symbologies listed below can be printed with the Card
Software.

3 of 9
(See Code 39)

Codabar
Codabar is a numeric, variable length, discrete, self-checking,
two-element width symbology used mostly by libraries,
package tracking systems, and blood banks. Developed in
1972, it was one of the original bar code symbologies. The
numbers 0 through 9 and the following six characters comprise
its character set: $ : / . + -

Code11
Code 11 is a variable-length, numeric, discrete, high density
symbology most frequently used to label telecommunications
components and equipment. Its name is derived from the fact
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that 11 different data characters can be represented in addition
to a start/stop character. The Code 11 character set comprises
the 10 digits plus the dash symbol. Each character is
represented by a group of three bars, with three different bar
widths and two included spaces, with two space widths.
Though Code 11 is a discrete symbology, it is not self-
checking; data security is obtained by using one or two check
digits.

Code 39
Code 39 (also called 3 of 9) is a variable length, discrete, self-
checking, two-element width symbology that was the first
alphanumeric symbology to be developed. Code 39 is currently
the most widely used bar code for industrial and commercial
(non-retail) purposes in the world. Every Code 39 character
has five bars and four spaces, making a total of nine elements.
Three of the elements are wide, hence the name 3 of 9. While
being very accurate, Code 39 is not a very dense bar code
symbology, taking many bars and spaces to represent a single
character. The Code 39 character set consists of the numbers
0 through 9, the upper-case alphabet, and the following
characters: - . $ / + % and Space. Asterisks are reserved as
the start and stop characters.

Code 93
Code 93 is a variable length, alphanumeric, continuous, four-
element width symbology specifically designed to
complement Code 39. The two symbologies can be freely mixed
in an environment with no software change required. Because
of its small size, it is used on electronic components, but it is
a not very popular bar code symbology.

Code 93 encodes 43 data characters consisting of: 0-9, A-Z, 6
symbols and space, four control characters and a unique start/
stop character. The entire ASCII character set can be encoded
using the expanded version similar to Code 39. Code 93 can
encode the same characters as Code 39, but has the advantage
of being smaller.

ap

U
ap
de

B
bo
ov

T
w
th
52
A
bi
m

Pr
va
fo

5.

6.

7.
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Code 128
Code 128 is a variable length, alphanumeric, continuous,
multiple-element width, high-density symbology used in the
shipping industry and on labels. The Code 128 character set
comprises 106 different printed characters, and will use the
least amount of space for data of six characters or more of any
one-dimensional symbology. Each printed character can have
one of three different meanings, depending on which of three
different character sets (A, B or C) is employed. Three different
start characters tell the scanner which of the character sets is
initially being used, and three shift codes permit changing
character sets inside a symbol. Every Code 128 symbol ends
with a check character.

EAN
EAN (European Article Numbering) is a numeric, fixed length,
continuous symbology that is a superset of the UPC bar code
used in the USA. There are two versions of EAN: 8 and 13
characters, similar to UPC-E and UPC-A respectively. EAN-13
adds a country code to UPC-A, resulting in a 13-digit number.
EAN-8 has two-digit country codes, five-digit data codes
identifying the product and the manufacturer, and a one-digit
check character.

EAN 128
EAN 128 is a variable length, alphanumeric, continuous,
multiple-element width, high density symbology. It is a
variation of Code 128, and exclusively reserved to EAN
International and the Uniform Code Council (UCC). It is not
intended to be used for data to be scanned at the point of sale
in retail outlets.

The encoded data contains an Application Identifier (AI),
which is a prefix code used to identify the meaning and the
format of the data that follows it (data field). There are AIs for
identification, tractability, dates, quantity, measurements,
locations, and many other types of information. For example,
the AI for batch number is 10, and the batch number AI is
always followed by an alphanumeric batch code not to exceed
20-characters. The EAN Application Identifiers provide an
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open standard, which can be used and understood by all
companies in the trading chain, regardless of the company
that originally issued the codes.

EAN-128 offers several advantages. It is one of the most
complete, alphanumeric, one-dimensional symbologies
available today. The use of three different character sets (A, B
and C) facilitates the encoding of the full 128 ASCII character
set. Code 128 is one of the most compact linear bar code
symbologies. Character set C enables numeric data to be
represented in a double density mode. In this mode, two digits
are represented by only one symbol character saving valuable
space. The code is concatenable. That means that multiple
Application Identifiers and their fields may be combined into
a single bar code. The code is also very reliable. Code 128
symbols use two independent self-checking features, which
improves printing and scanning reliability.

EAN-128 bar codes always contain a special non-data character
known as function 1 (FNC 1), which follows the start character
of the bar code. It enables scanners and processing software
to automatically discriminate between EAN-128 and other bar
code symbologies, and subsequently only process relevant
data.

The EAN-128 bar code is made up of a leading quiet zone, a
Code 128 start character A, B, or C, an FNC 1 character, Data
(Application Identifier plus data field), a symbol check
character, a stop character, and a trailing quiet zone.

Industrial 2 of 5
Industrial 2 of 5 is an older, numeric, discrete, self-checking,
low density symbology that has been used for warehouse
sorting systems, photo-finishing envelope identification, and
airline ticket numbering. All information is encoded in the
width of the bars, with the spaces serving only to separate
the bars. Bars are either wide or narrow. By convention, the
wide bar is three times the width of the narrow bar, and the
space is typically the width of the narrow bar.

Narrow bars are read as a 0 bit and wide bars as a 1 bit. With
the exception of the zero, start, and stop digit, the characters
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are weighted left to right as 1, 2, 4, 7 and parity. The character
set comprises the ten digits plus a start and a stop character.

Interleaved 2 of 5
Interleaved 2 of 5 is a variable length, numeric, continuous,
self-checking, high density symbology mainly used in the
distribution industry. Each bar code character encodes two
numbers, one in the spaces and one in the bars. There are five
bars and five spaces, with two of the five in each being wide.
Since each bar code character represents two numbers, all
Interleaved 2 of 5 bar codes have an even number of digits.

The start code is two narrow bars with two narrow spaces.
The stop code is one wide bar, one narrow space, and one
narrow bar. These relatively crude start and stop codes can
allow a partial scan to result in a valid but incomplete code.
Therefore, this symbology is best used with fixed length
applications where the decoding equipment is programmed
to accept scans with only the correct number of digits.

MSI
MSI is a numeric, variable-length (up to 13 digits), continuous,
low-density, symbology developed in the early 1970s for
(mainly) retail shelf marking and inventory control.

Each four-bit character is 12 units wide, with each zero bit
being a one-unit bar followed by a two-unit space, and each
one bit being a two-unit bar followed by a one-unit space.

The complete symbol includes a start pattern, data characters,
one or two check digits, and a stop pattern. Though MSI is a
variable-length symbology, it is usually used in a fixed-length
format since it is not self-checking. The character set comprises
the ten digits plus six additional characters.

UPC-A
UPC-A (Universal Product Code) is a numeric, fixed-length
(12 digits), continuous, four-element width symbology and
encoding system, used since 1973 almost exclusively by the
retail industry. This makes UPC the most widely used bar
code in North America.
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It was designed to uniquely identify a product and its
manufacturer. In the U.S., manufacturers numbers are assigned
by the Uniform Code Council in Dayton, Ohio.

It is important to differentiate between the UPC coding scheme
and the UPC symbology. The actual UPC code is a 10-digit
code: the first five digits represent the manufacturer, and the
next five digits contain a unique product number. This 10-
digit code is preceded by a “number system” digit and
followed by a check digit, based on the preceding 11 digits
and used for error detection.

UPC-E
UPC-E is also a numeric, fixed-length symbology, but is limited
to six digits versus the 12 digits of UPC-A. It is used where
space is at a premium, such as a small product label.

Telepen
Telepen is an old, numeric two-part symbology used mainly
in England.
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18. About PDF Symbols

About Two-dimensional Bar Codes
· The typical bar codes we have been discussing in

Chapter 20, Appendix D, “About Barcodes” are one-
dimensional. Since they have height and width, you
may wonder why they are called one-dimensional. It’s
because when they are read, it is only the width of the
bars and spaces that is taken into account. The height
of the bars is only to give the symbol some built-in
redundancy. Typical bar code symbols, therefore, are
only read in one dimension. Another important aspect
of one-dimensional bar code symbols is that they
seldom represent more than a dozen characters.
Therefore, the bar code usually does not contain any
data, per se. Rather, the bar code most often represents
the key to a record in a database, where the related
information is stored.

· Two-dimensional (2D) bar code symbols surpass these
two preclusions. Data is encoded in both the height
and width of the symbol, and the amount of data that
can be contained in a single symbol is significantly
greater than that stored in a one-dimensional symbol.
In fact, over a thousand alphanumeric characters can
be placed in a single symbol the size of a large postage
stamp! Obviously, the main advantage of using 2D bar
codes is that potentially a large amount of easily and
accurately read data can accompany the item to which
it is attached. There are new applications being created
for 2D bar code technology every day.

· The reading (scanning) of 2D codes is accomplished
using different scanners than those made to scan 1D
symbols. Two strategies are currently used. The first
and most common, uses a moving laser beam scanner
that not only sweeps back and forth across the symbol,
but also up and down in what is termed a “raster”
pattern. Alternately, CCD (charge-coupled device)
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scanners are used. CCD scanners use a two-dimensional
array of photo-sensors to scan the image in its entirety.

· One of the beneficial aspects of two-dimensional
symbols is their potential durability. To sabotage the
readability of a 1D symbol, one only has to add another
bar to the beginning or end of the symbol or draw a line
through the symbol, parallel to the stripes.

· This throws off the checks and balances, built into the
decoding algorithms of a 1D decoder and makes the
symbol unreadable. By comparison, many degrees of
redundancy can be built into a 2D symbol. While it
makes the symbol somewhat larger, the remaining
symbol is remarkably secure.

· There are a number of two-dimensional symbologies
in growing use today. The 2D bar code supported by
the Card Software is PDF417.

PDF417
· PDF417 is a multi-row, two-dimensional, high-capacity,

high-density bar code developed by Symbol
Technologies, Inc. and announced in 1990. It essentially
consists of a stacked set of smaller bar codes. The
symbology is capable of encoding the entire (255
character) ASCII set. PDF stands for “Portable Data
File” because it can encode as many as 2725 data
characters in a single bar code comprising 17 modules,
each containing 4 bars and spaces (thus the number
“417”). Each symbol has a start and stop bar group
that extends the height of the symbol.

· The complete specification for PDF417 provides many
encoding options including data compression options,
error detection and correction options, and variable
size and aspect ratio symbols. The low level structure
of a PDF417 symbol consists of an array of code words
(small bar and space patterns) that are grouped to-
gether and stacked on top of each other to produce the
complete printed symbol. An individual code word
consists of a bar and space pattern, 17 modules wide.
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The user may specify the module width, the module height,
and the overall aspect ratio (overall height to width
ratio) for the complete symbol. A complete PDF417
symbol consists of at least 3 rows of up to 30 code
words and may contain up to 90 code word rows per
symbol with a maximum of 928 code words per symbol.

· The code words in a PDF417 symbol are generated
using one of three data compression modes currently
defined in the symbology specifications. This allows
more than one character to be encoded into a single
data code word. Because different data compression
algorithms may be used, it is possible for different
printed symbols to be created from the same input data.

· The symbology also allows for varying degrees of data
security or error correction and detection. Nine different
security levels are available with each higher level
adding additional overhead to the printed symbol.
Using a higher level of security will give you a better
chance to decode information in a damaged bar code.
The error-correction capability uses built-in error
detection code words, to reconstruct partially
destroyed bar codes. It works by checking the value of
columns and rows, and then calculating and rebuilding
the data missing from any damaged cells.
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19. The Twain Interface

This section explains the Twain interface.

Overview of Twain
Twain is an industry-standard protocol for ex-changing
information between application software (like this Card
Software) and image capture devices such as scanners or
video cameras.

It was developed by a coalition of imaging hardware and
software manufacturers, and eliminates the need to close the
application software in order to scan an image.

Goals of Twain
The primary purpose of Twain is to solve the need for
consistent, easy integration of sophisticated input devices
and the information they generate for use in any Twain-
compliant software.

The Twain Process
The Old Way

In the past, the process for scanning images into an application
was to:

1. Create a document in an application.
2. Close the application.
3. Open the scanning software.
4. Scan the image.
5. Save the image to a file.
6. Close the scanning software.
7. Open the document application again.
8. Find the scanned image file.
9. Import the image file.
10. Place and size the image in the document.
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The Twain Way
With Twain hardware and software the process is to:

1. Create a document in an application.
2. Select Acquire from the document application’s File menu.
3. Click final scan from the Twain source.
4. Place and size the image. Obviously, the process of

acquiring images has been greatly simplified.

History of the Twain Consortium
In early 1990, a substantial number of industry representatives
joined the Macintosh Scanner Roundtable, which was formed
by Dave Nelson of Nuvo Labs. This group broadened industry
awareness of the need for an open interface, and defined
technical issues for the integration of raster (bitmap) devices
and applications.

While participation was active, it was difficult to resolve issues
and progress was slow. At one of the Roundtable’s last
meetings in 1990, it was suggested that a small group of
industry leaders form a consortium and create a specification
for review, revision, and ultimate adoption by the imaging
industry.

The “Twain” consortium was formed soon after that from
representatives of Aldus, Caere, Eastman, Kodak, Hewlett-
Packard and Logitech. The goals of this smaller workgroup
were to resolve technical and marketing issues of the open
interface as quickly as possible, and then to circulate the
specification among the developer community for review and
feedback.

The group was designed to be as small as possible (so the
specification could be written quickly), while maintaining
representation from a wide spectrum of application developers
(desktop communications and OCR) and hardware vendors
(hand-held scanners, desktop scanners, and high-end color
scanners).

Working group members represented diversity in the industry,
and brought in-depth imaging experience to both the hardware
and software development and marketing fields.
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A key requirement of participation was that companies in the
working group have been willing to represent an interest,
passing the elementary interest of each company. The primary
goal of this effort was to raise the awareness of a new end-
user base through an easy-to-use image acquisition
functionality integrated directly into the user’s application
and work flow.

The effort was successful and resulted in the Twain interface
specification.
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20. ODBC Advanced Notions

This section explains the ODBC (Open Database Connectivity)
architecture.

ODBC Components
· The ODBC architecture has four components:
· Application: Performs processing and calls ODBC

functions to submit SQL (Simply Query Language)
statements and retrieve results.

· Driver Manager: Loads drivers on behalf of an
application.

· Driver: Processes ODBC function calls, submits SQL
requests to a specific data source, and returns results
to the application. If necessary, the driver modifies an
application’s request so that the request conforms to
syntax supported by the associated DBMS (Database
Management System).

· Data Source: Is the data the user wants to access and
its associated operating system, DBMS and network
platform (if any) used to access the DBMS.

Application
An Application using ODBC performs the following tasks:

1. Requests a connection, or session, with a data source
2. Sends SQL requests to the data source
3. Defines storage areas and data formats for the results of
SQL requests
4. Requests results
5. Processes errors
6. Reports results back to a user, if necessary
7. Requests commit or rollback operations for transaction
control
8. Terminates the connection to the data source
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Driver
A driver is a DLL that implements ODBC function calls and
interacts with a data source (a data source includes the data a
user wants to access and the information needed to get to
that data).

The Driver Manager loads a driver when the application calls
it.

A driver performs the following tasks in response to ODBC
function calls from an application:

· Establishes a connection to a data source
· Submits requests to the data source
· Translates data to or from other formats, if requested by

the application
· Returns results to the application
· Formats errors into standard error codes and returns them

to the application
· Declares and manipulates cursors if necessary. (This

operation is invisible to the application unless there is a
request for access to a cursor name)

· Initiates transactions if the data source requires explicit
transaction initiation. (This operation is invisible to the
application)

Driver Manager
The Driver Manager, is a dynamically linked library (DLL)
with an import library. The primary purpose of the Driver
Manager is to load drivers. The Driver Manager also performs
the following:

1. Uses the ODBC.INI file to map a data source name to a
specific driver dynamically-linked (DLL)

2. Processes several ODBC initialization calls
3. Provides entry points to ODBC functions for each driver
4. Provides parameter validation and sequence validation

for ODBC calls
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Data Source
Database Management Systems (DBMS) refer to the general
features and functionality provided by an SQL database
management system.

A Data Source is a specific instance, a combination of a DBMS
product and any remote operating system and network
necessary to access it.
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21. Appendix A - Printing & Ribbon

This section explains how to setup your printer, the setup for
ribbon and the procedure to print your cards. For specific
information about your printer, see the printer user manual.

Printer Setup
Before you use a specific printer for the first time you must tell
the program which printer port to use. In most cases the default
configuration makes this step obsolete.

The Card Software supports all Eltron Privilige Series of card
printers (300, 400, 500 and 600), called Specific printers and
also supports any Windows Printer Driver.

Specific Printer
The Eltron Privilege Series of card printers are high quality
printer family specifically designed for printing and encoding
of credit card style plastic cards. The Privilege Series of card
printers are ideal for personalised identification, access con-
trol, visitor, membership, promotion, etc. card.

P300 - Includes a Print Station.

P400 - Includes a Print Station and a Card-Flip Assembly.

P500 - Includes a Print Station, a Card-Flip Assembly, and a
Lamination Station.

P600 - Includes two Print Stations separated by a Card-Flip
Assembly.

Specific Privilege Printer Properties
From the File menu , click Printer Setup. The Printer Setup
dialog box appears. Check the Use Specific Printer option
and select the type of the Privilege printer you want to work
with.
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Click Properties and the selected printer properties dialog
box appears.

Card
Click the card tab which allows you to change the card
orientation. When you change the card orientation, the Card
Software transfers the top and bottom margin measurements
to the left and right margin measurements.
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Check the kind of orientation you want to work with.

Use the Print Self Test to send a test card to the printer. You
might want to do this to make sure your printer is setup
correctly. Eprom version, head settings and serial number of
the printer is printed on the test card.

Click Ok to close the printer properties dialog box.

Ribbon
Click the Ribbon tab to setup the ribbon you want to use.
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Ribbon Types
· 3 Panel Color Ribbon (CMY): This ribbon has sections

comprising three dye-sublimation panels (yellow, magenta,
cyan).

· 4 Panel Color Ribbon (CMYK): This ribbon has sections
comprising three dye-sublimation panels (yellow, magenta,
cyan) and a black resin panel.

· 5 Panel Color Ribbon (CMYKV): This ribbon has sections
comprising three dye-sublimation panels (yellow, magenta,
cyan), a black resin panel, and an overlay panel.

· 6 Panel Color Ribbon (CMYKVK): Used only with the
Privilege 400 series printers, this ribbon has sections
comprising three dye-sublimation panels (yellow, magenta,
cyan), a black resin panel, an overlay panel, and an
additional black resin panel. The last black panel can only
be used to print on the back surface of the card. This ribbon
selection is used in conjunction with the Front and Back
options below.

· Monochrome Ribbon (K): This is a single-color resin ribbon,
available in ten colors.

· Black Sublimation Ribbon + Overlay (SV): This ribbon
has sections comprising one black dye-sublimation panel
plus one overlay panel.

· Black Resin Ribbon + Overlay (KV): This ribbon has
sections comprising one black resin panel plus one overlay
panel.

· Overlay (V): This ribbon is a single overlay panel ribbon.
· Hologram: This ribbon is a single hologram panel ribbon.

Note: Because of their ability to print varying color and gray
scale images, dye-sublimation ribbons are best used to print
photographs and other graphics. Resin ribbons are more
durable and resistant to scratching, so are best suited to print
bar codes and text.
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Setting the Ribbon Type
¨  Set the ribbon type for your Privilege Printer

To produce proper print results, the Card Software must know
the type of ribbon that is installed in the printer.

1. To setup the ribbon type of your printer, select Printer
Setup from the File menu. The Printer Setup dialog box
appears.

2. Check Use Specific Printer and select your printer type
name. Click Properties. The specific printer dialog box
appears. Click the ribbon tab.
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Tip:  You can also access the Printer Properties box from within
the Card Print dialog box.

3. Click the radio button for the proper ribbon type installed
in your printer and (if using a P400 printer or greater ) the
front/back color choices. Confirm with OK.

Setting the P400 or greater
Because the P400, or greater printers are able to print on both
sides of the card, you can choose the colors to be used on
each side. For the listed ribbons, the Card Software allows the
following front/back color combinations.

Note: The 5 Panel ribbon does not support the Print in Black
Panel function for the front/back combination Color-Black
and Black-Color. You have to use the 6 Panel ribbon instead.

Ribbon Front Back
3 Panel Color Color Color

Color Color
4 Panel Color Color Black

Black Color
Color Color

5 Panel Color Color Black
Black Color
Color Color

6 Panel Color Color Black
Black Color

Monochrome One color One color
Black Sublimation + Overlay Gray Gray
Black Resin + Overlay Black Black
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Encoding
Click the Encoding tab to change the encoding settings.

The Direct Encoding section allows you to read or encode the
data of the checked track(s). The following table lists the
number and type of characters allowed for each of the three
tracks.

Note: For more information see Chapter 22 - Appendix B
“Magnetic Encoding”.

Track Character Limit Allowed Characters
1 79 alphanumeric ASSCII codes 32-95 Field

Separator is ^
2 40 numeric ASCII ASSCII codes 48-63 Field

Separator is =
3 107 numeric ASCII ASSCII codes 48-63 Field

Separator is ^



198 Card Software User Manual

Tools
Click the Tools tab to communicate directly with the printer.

The Manual Commands field allows to execute various printing
commands. See your Privilege card printer manual.

The Eject Card button moves and exits a single card from any
position between the card feeder and the output tray and
automatically synchronizes the ribbon.

The Synchronize button automatically synchronizes the
selected ribbon.

Head Settings
Click the Head Settings tab to adjust the black and white
contrast, the color contrast and the color intensity for the
head printer.
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Color Intensity - Sets the values of yellow, magenta and cyan,
and dye diffusion to adjust the amount of heat applied, to
transfer a maximum intensity color or monochrome dot.

Warning : High color intensity setting may cause ribbon
rupture.

Color Contrast - Sets the values of yellow, magenta and cyan,
and dye diffusion to adjust the amount of heat applied, to
transfer a maximum intensity color contrast.

Contrast - Sets the values of overlay, black and hologram, to
adjust the amount of heat applied, to transfer a maximum
contrast.

Warning : Do not change the default values without consulting
your Privilege card printer manual first.

Use the Default button to reset the settings in this tab to the
original values.
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Printer
Click the Printer tab to configure the printer port and the
printer capabilities.

Select the printer port to which you connected your printer,
usually LPT1.

Use the Handshake button to recognise the printer capabili-
ties directly (only available when the Direct Print  options is
checked). Or if you know the printer capabilities check them
manually.

The printer capabilities are listed below:

Extended Memory - It’s an hardware option. There are two
main advantages with this option: speed on printing process
and ability to cards edge to edge.

Print Both Sides - ability to print both sides of the card. Only
available for P400 or greater.

Chip Card Processing - allows to plug in an exe file (typically
a chip card processing software) during the printing process.

Laminate - Allows you to laminate the card. Only available if
you have a P500.

Choose the type of magnetic encoder installed in your printed.
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Special P500 Properties
A P500 printer includes a print station, a card-flip assembly
and a lamination station. This means that, if you use a Privilege
P500 the Card Software allows you to laminate cards as wel as
to print both sides of the card. The Lamination tab allows you
to configure the lamination process.

You can Laminate your card either with Varnish or with P500
Overlaminate, check the type of film you will be using for the
lamination process.

Varnish:  select this option if you use an overlay film

P500 Overlaminate: select this option if you use the
overlaminate film

In the Front/Back section,  check operation you want on each
card layer:

Lamination Station enabled: allows lamination on
print station 2

Overlay on Print Station enabled: allows overlay
printing on print station 1

The Head Temperature allows you to adjust the temperature
for the lamination.

The Card Speed allows you to adjust the speed of the
lamination process
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Defaults: Sets Card Speed and Temperature at their default
values.

Special P600 Properties
A P600 includes two print stations, separated by a card-flip
assembly, this means that if you use a Privilege 600 the Card
Software allows you to increase the printing speed using two
print station at the same time as well as permits to combine
different types of ribbon.

As the P600 consist of two print stations, both have to be
configured.

· The types of ribbon available are equal  (see above in this
Chapter “Ribbon Types”) for both stations. Click the ra-
dio button for the proper ribbon type installed  in each
printer station.

· The Card Software displays a Warning message, if you
set a ribbon combination not suitable for the P600.
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Print with Windows Driver
Printer Types

The Card Software allows you to print on any printer which is
provided with a proper Windows driver.

Card Printer

Using the proper Windows printer driver for your card printer
the Card Software allows you to use any card printer. For
special printer/ribbon settings see your card printer
documentation as well as related help files.

Besides that the Card Software allows you to use any card
printer it also permits to work on card layout, database edition,
etc. at print time simultaneously.

Label Printer

The Card Software allows you to print on any Label printer
which is provided with its proper Windows driver.

Note: the label size settings must have the same measurements
as the standard plastic card format (88.7 x 54.2 millimeters).

Paper Printers

The Card Software permits to print on paper with any Laser,
Ink Jet or Needle printer, which comes with a proper windows
driver. The Card Software’ s special column and row settings
permit to print front and back side of the card on the same
sheet as well as several cards on one sheet. This concept
permits to print card proofs on paper or creating low cost
cards using paper lamination.
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Card Setup
¨  Setting up the card

1. To setup the card, using a Windows Printer Driver, from
the File menu choose Printer Setup. Select Use Windows
Printer  and choose the printer name you want to work
with. Click Ok.

2. The properties button allows you to perform driver driver
specific settings (see your printer documentation) like
paper size, orientation, etc.

3. From the File menu choose the Card Setup. The selected
printer dialog box appears.
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4. Set the card orientation to Portrait or Landscape. The
paper section displays the paper size you defined when
setting your printer properties (see above, steep 2). The
Card Software allows you to print both sides of the card
on the same page (when using paper), for that select 2 in
the cols section. The Card Software allows you to print
several cards by page (when using paper) for that select
the number of rows to print (max 5).

Printing Cards
Printing cards with the Card Software is easy. It’s the final
step after the card design process.

¨  To print cards

1. From the File menu, choose Card Print; the Card Print dialog
box appears.

2. Select the Destination corresponding to the installed card
printer. Use the properties button to change the selected
printer configuration. Destination may be specific printers
any printer through Windows driver or the print manager
(printing to a batch file).
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3. In the Operation section, select the operation(s) to perform
when printing.

· Print will print a card containing all the objects
you placed on the card.

· Encode will write data to the magnetic stripe on
the card (see Chapter 22 - Appendix B “Magnetic
Encoding”).

· Chip Card Processing will call an external chip
card processing application (see Chapter 9 -
“Chip Card”).

· Hologram will print a hologram on your cards.
Contact your ribbon supplier to inform you
about hologram ribbons.

4. If you use a Privilege 400 or greater card printer check
both Print Front and Print Back to print both sides of the
card in one passage. Select Rotate 180 Degrees if you
want the card to be printed “upside down” , this options
is available for each card layer separately. This feature can
be used if, for example, you wish to punch a hole in the
card on the opposite side of the magnetic stripe, avoiding
that way to damage the stripe.

5. In the Print Range section select Single (1) or Multiple (2
or more) cards to print. If printing multiple, enter the number
of cards to be printed.

6. If you using a database (Advance Feature) select the Print
All box to print all records, or the type the Number of
Records to be printed.

7. In the Copies section enter the number of copies of each
card to be printed.

8. Click OK . If you are printing variable data, you may be
prompted to enter data from the keyboard, select an image
file or acquire an image. Otherwise, your card will be
printed, while on-screen messages keep you informed of
the progress.
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Print Manager
Advanced Feature

The Card Software allows you to create a batch file, which
contains data of one or more card documents instead of
printing the card documents right away.

Printing to a File
¨  To create a batch print file

1. From the File menu, choose Card Print . You can also
press the shortcut Ctrl+P . The Card Print dialog box
appears.

2. In the Destination section select the Print Manager . In
the Operation section choose Print .

Note: All other options work the same way as printing a card
document directly (see above “Printing Cards”). If you want
to print multiple cards and/or multiple copies, perform magnetic
encoding or chip card processing you have to set these
options before you proceed with step 3.
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3. Click OK . The Select Batch Print File dialog box appears.

4. Select the file you want to append, or create a new batch
print file giving a new name.

5. Click Open to complete the action. The Batch Print Job
List and Batch Print Preview windows open.

The Batch Print File Manager
¨  To print cards

1. From the File menu, choose Batch File Manager. The
Select Batch Print File dialog box appears. Select the name
of the document you want to open and click OK . The
Batch Print Job List and Batch Print Preview windows
appear.

Note: The Batch Print Job List contains card documents (*.car)
itself and the (multiple) cards inside each card document.
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2. Browse through the Batch Print Job list using the Move
buttons at your Batch Print Toolbar. You can also use the
up and down arrows of your keyboard.

3. You can control the card design and its variable fields (in
case your card document contains multiple cards) in the
Batch Print Preview window. To toggle between both sides
of the card click the Front/Back View button.

4. Select the card document you want to print. Click the
Print button at your Batch Print Toolbar.

Tip:  If the selected card document contains multiple cards,
you can print one specific card by selecting it instead of the
card document itself.
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Batch Print Options
¨   Print Status Symbols

 To Print: Cards marked with this symbol are ready to print.

 Error : If  an error occurrs while printing, the card marked is
with this symbol.

 Printed: Cards marked with this symbol were printed
properly.

 Held: Cards marked with this symbol are excluded from
printing.

· Printing using Print Status: Double-click the card
document you want to print. The Status to Print dialog
box appears. Select the status you want. All cards marked
with the corresponding symbol will be printed. Click
Continue to proceed.

Tip:  You can manually change the Print Status of each card.
Select the card you want to change. Click the status symbol
you want at the Batch Print Toolbar. If you want to change the
print status equally for all card included in the card document,
select the card document and click the status button you
want apply.
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Print Tools
The Card Software offers a build-in Printer Tool, which you
can access from the Printer Setup. The Printer Tools allows
you to communicate directly with the printer.

Build-in Printer Tool
To access the build-in Printer Tool, select Printer Setup from
the File menu. The selected Printer Tools dialog box appears.
See above “Specific Privilege Printer Properties”.
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22. Appendix B - Magnetic Encoding

If your printer is equipped with a magnetic stripe encoder,
you can encode data onto cards that have an embedded
magnetic stripe.

About Magnetic Stripe
· There are two kinds of magnetic stripe cards: low

coercivity and high coercivity. (Coercivity is the
measurement of a magnetic material’s resistance to being
magnetized. Low coercivity material magnetizes easier
than high coercivity material.) A magnetic stripe encoder
is designed to be used with one type of cards only, either
high or low coercivity.

Caution: High and low coercivity cards are not
interchangeable. Refer to the printer manual to ensure that
you have the correct type of card for your model printer.

· There are three magnetic tracks on a magnetic stripe card.
To comply with international standards, each track is
limited to a certain number and type of character.

· In addition to the user data, three format characters are
added automatically by the printer. The data on each
track is preceded by a Start Sentinel, then followed by a
Stop Sentinel and Longitudinal Redundancy Check (LRC)
character.

Important : Although the printer automatically inserts these
three format characters at print time, you must include them in
your character count to stay within the allowable character
limit for each track.

· The following table lists the number and type of
characters allowed on each of the three tracks.
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Encoding a Magnetic Stripe
There are three ways to use the Card Software to encode a
magnetic stripe:

1. To encode a small number of cards,  choose Printer Setup
from the File Menu, the Printer Setup dialog box appears.
Select the specific printer name for your printer and click
Properties. The selected printer properties dialog box
appears. Click the tab Encoding.
· For each card, you must manually type in the
information you want to be encoded on each track. It is
not very efficient, but is okay for a few cards.
· Also, you can use this method to erase the magnetic
information from a card or to re-encode a card with the
same or different data.

2. To encode more than a few cards, use the Magnetic
Encoder Tool on the lower tool-bar. This more efficient
method uses variable data fields in the same way you
used them to print variable bar codes, and is preferred
when printing imported data.

3. To encode using a Windows Printer Driver you will need
to configure the magnetic encoding.

Important : When using either encoding method, ensure that
the magnetic stripe cards are properly oriented in the card
feeder. Typically, the magnetic stripe is oriented on the bottom
of the card and toward the back of the printer. Refer to the
printer user manual for more information.
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Encoding with Specific Printer Properties
¨  To use the Printer Properties method

1. From the File menu, choose Printer Setup. The Printer
Setup dialog box appears. Select the specific printer name
for your printer and click Properties. The selected printer
properties dialog box appears.

2. Click the Encoding tab. In the Direct Encoding section
select the check box for each track you want to encode.

Tip : To erase magnetic data from a card, select all three track
check boxes, but leave the data boxes blank.

3. In the box to the right of the track number, type the data
you wish to encode.

Important : You must keep the number of characters (Including
the three format characters) within the limits listed previously
for each track. The Card Software will not prevent you from
entering too many characters.

4. Click Encode. The printer will feed a card through the
encoding station in the printer and encode the data on
the card.

5. If you do not wish to print anything on the card, click
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Eject Card and the card will pass through the printer to the
card out-put tray.

6. If you wish to print on the card, click Ok, then proceed
as you would for printing a non-magnetic card. Don’t
forget to enable Encode in the Card Print dialog box.

Magnetic Encoder Tool
¨  To use the Magnetic Encoder tool

  1.On the Drawing toolbar, click the Magnetic Encoder
tool. The Magnetic Code Object Properties dialog box
appears.

             

2. Select the Encode check box for each track (1, 2 or 3) you
wish to encode.

3. If the data for a track will not be changing from card to
card, type the data in the Default Code box for that track.
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4. If the data for a track will be changing from card to card, in
the Variable Source box select the variable that is going to
provide the data for that track.

5. Repeat steps 3 and 4 for each track you wish to encode.
6. When finished, click OK .

  7.On the Standard toolbar, click the Printer tool. The
Card Print Dialog box appears.

8. Select the Encode check box to enable magnetic stripe
encoding.

9. If printing more than one card, click Multiple , and then
type or select the number of cards to print. Type or select
the number of Copies of each card to print.

10.Click OK , to print the card(s).
11.Every card will be magnetically encoded with the speci-

fied data. If the Print check box from the Operations sec-
tion is enabled, printing starts after the encoding process.
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Encoding with a Windows Printer Driver
¨  To use the Windows Printer Driver

1.   From the File menu, choose Printer Setup. The Printer
Setup dialog box appears. Select the Use Windows Printer
option and select the printer you want to work with. Click
Ok.

2.  From the File menu, choose Card Setup. The selected
printer dialog box appears. Click the Magnetic Encoding
tab.

3.  Check the Send Magnetic Encoder Data option and
configure the macro. Remember that the Start of Data macro
must be identical to the driver macro.
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Important : The default Card Software macro is a Fargo
compatible.

Note: If your printer track list is 0, 1, 2 please replace the X
(capital case) for a x (lower case) on the macro.

4.  From the File menu, choose Card Print . The Card Print
dialog box appears. Check the Encode option, confirm all
the others print operations and click Ok.
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Basic Features

23. Appendix C - Card Software Basic
Features

The Card Software  is provided in 3 editions, PREMIER,
PROFESSIONAL and MULTISTATION. This section gives
an overview of the basic features. PREMIER contains all the
basic features, PROFESSIONAL all PREMIER features,
MULTISTATION contains all PROFESSIONAL features.

· Setup program on CD
· Wysiwyg multi–document interface
· Rich set of design tools oriented to card design
· Full text treatment: multi-line, rotation, color, size,

alignment
· Bar code; 17 types available, resize, check digit and more
· PDF417, up to 64K in a bar code symbol
· 3 tracks magnetic encoding
· Plug-in for external chip card processing software
· Image import from file in several formats
· Image acquisition using Twain Interface
· Modify images with built-in Image Tools
· Printing Hologram Ribbon
· Overlay clipping and image import for security
· Independent overlay for Front & Back
· System Variables: counters, time, date, and keyboard input
· Supported printers: Privilege 300, 400, 500 and 600

(Professional P600 edition support the P600 printer)
· Ability to use any Windows printer driver.
· Fast printing speed - optimized for multiple cards
· Front & back printing
· On-line manuals & Acrobat Reader
· Clipart Volume I
· Multi-lingual; English, French, German, Italian, Spanish

and Portuguese
· Ease of use - light software for heavy duty card design
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Premier
· Database variables
· Internal database
· Fast database editing with EOF-options
· Encoding photos in PDF symbol
· Printed manual
· Software Key
· Clipart Volume II
· Paint Shop Pro shareware
· Adobe Acrobat Reader

Professional
· Logins and password for maximum access security
· External database and ODBC Administrator to access all

major database formats.
· Print Database reports on paper
· Database properities including image compression, define

view to hide and unhide fields, browse view for tabel
listing

· Batch Printing from file
· VfW video source supported

Multistation
· Supports multistation printers .
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